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Preface 1
1.1 About this manual 

Purpose of the manual 
This documentation provides you with a complete overview of the configuration and 
operation of RFID systems with SIMATIC RF-MANAGER Basic V3. The manual supports 
you in creating new projects, in the procedure used during configuration and in executing 
projects. 

The manual is intended for users and project engineers involved in the configuration, 
commissioning and servicing of RFID systems using SIMATIC RF-MANAGER Basic V3. 

Contents 
This documentation will familiarize you with the components of the SIMATIC RF-MANAGER 
Basic V3 software: 

● SIMATIC RF-MANAGER Engineering System (ES): Engineering software for creating 
and processing RFID projects 

Basic knowledge required 
General experience in the field of automation technology and RFID technology is essential 
for understanding this manual.  

It is assumed that the reader is competent in the use of personal computers with the 
Windows XP Professional or Windows 7 Professional operating system.  

Conventions 
In this manual, the product SIMATIC RF-MANAGER Basic V3 is also referred to as RF-
MANAGER Basic. 

Scope of validity 
The manual is applicable to SIMATIC RF-MANAGER Basic V3 and describes the status of 
the product as of August 2012. 
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History 
 
Edition Remarks 
06/2011 First edition 
03/2012 Revised and extended edition 
09/2012 Revised and extended edition, 

updated to V3 

1.2 Further information 

Additional documentation 
Further RFID documentation for RF-MANAGER Basic: 

● SIMATIC RF600 System Manual 

This manual contains the information needed to plan and configure the SIMATIC RF600 
system. 

● SIMATIC RF Function Manual 

This manual is intended for advanced users and describes the XML-based programming 
interface of the RF600 reader family with an Ethernet interface and the system alarms. 

Documentation can be downloaded from Support homepage 
(http://www.siemens.com/automation/service&support). 

 

 Note 
Detailed information is available in the Information System 

This manual provides a comprehensive overview of RF-MANAGER Basic V3. You will find 
detailed information about the individual topics in the Information System. 

 

 

http://www.siemens.com/automation/service&support�
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1.3 Guide to the documentation 
 
Content structure   Content 
Table of Contents Organization of the documentation, including the index of pages and chapters 
Preface Purpose, structure and description of the important topics. 
Introduction to the RF-
MANAGER 

Introduction to the programming interface and RF-MANAGER architecture 

Installation of the RF-
MANAGER Basic 

Description of the installation 
Basic information about RFID, tag detection, and interaction with the RF-MANAGER 

Working with RF-MANAGER 
Basic 

Description of the programming interface 
Description for creating, testing, and transferring a project 
Describes all tabs of the program and their detailed functions 
Description for working with system functions and functions lists and their significance 

Reference  Description of the system functions of RF-MANAGER Basic 
Service & Support Contacts, contact addresses, links, and further information 
Appendix Error messages and flash codes, license agreements 
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Introduction to the RF-MANAGER 2
 

The RF-MANAGER Basic is used for user-friendly configuring and commissioning of RFID 
readers. The following RF600 readers are supported at this time: 

● SIMATIC RF640R 

● SIMATIC RF670R 

These readers can currently be operated with the following antennas: 

● RF620A 

● RF640A 

● RF642A 

● RF660A 
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RF-MANAGER workbench 
When you create a new project in RF-MANAGER Basic or open an existing project, the 
RF-MANAGER workbench is displayed on the screen of the configuration computer.    

 
① Menus and toolbars 
② Workplace 
③ Property view 
④ Output window 
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Configuration via tabs 
In RF-MANAGER Basic, there are special input possibilities in the various tabs for each 
component of the reader: 

 
Tab Configuration options 
RFID device Basic reader settings 
Antennas Antenna settings. 
Data sources • Which data should the reader read? 

• How should the data be read? 

I/O Ports Behavior of digital inputs/outputs.  
Here you can specify, for example, when an automatic reset should occur. 

Notification channels When should the data be sent to the user application via the XML interface. 
Trigger Here you can configure when the data should be read from the reader. 
Data selector Which data should be made available to the user application via the XML 

interface. 
Tag selector Definition of the memory ranges from which data is read. Definition of filter 

criteria. 

Options after the configuration 
After you have made the necessary settings for the reader, there are the following options: 

● You can check the project for impermissible settings. 

● You can transfer the project to the reader. 

● After the transfer, you can check the real operation of the reader using a diagnostic view. 

● You can export the project to an xml file. Using an application, you can transfer this file to 
the reader at a later time via the xml interface. 

All project configuration data related to a project is stored in the project database.  
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2.1 Overview of the RF-MANAGER architecture 
Before you configure your RFID system with RF-MANAGER Basic, you should familiarize 
yourself with the individual components of the system. These components are described 
below, on the basis of typical scenarios, and their interdependencies are presented. 

2.1.1 Scenario 1: Monitoring incoming goods 
The scenario comprises an RFID system with an RF670R reader. Its four antennas monitor 
the incoming goods portal of a production hall through which pallets are delivered. Each 
pallet is equipped with a tag. The tags contain user data that provide information about the 
sender and receiver of the goods. These data are read out and passed on.  

 
Figure 2-1 Scenario 1: Monitoring incoming goods 

The reader is connected to the RF-MANAGER for configuring and commissioning and 
connected to an user application via an XML interface. The user application receives the 
data of the tags in the form of reports or by executing XML commands. For this example, you 
must configure the components described below in RF-MANAGER.  
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Diagram in RF-MANAGER 

 

RFID device  
The RFID device comprises function blocks which are configured in the RF-MANAGER and 
represent a reader. The following function blocks are active in this reader: 

● Antennas 

● Data source 

● Notification channel 

● XML interface 

Antennas 
The four antennas read the data of the tags that are attached to the pallets for incoming 
goods and forward the data to the data source.  

Data source 
Data sources are the basic components for reading RFID data. They encapsulate the 
antennas assigned to them and the data that is received by them through to the subsequent 
function units. In this example, one data source is sufficient for the four antennas assigned to 
it, because only the incoming goods portal is monitored. 
It is a general rule that one RFID device can also contain several data sources. Various 
different data sources can be defined so that mutually independent tasks can be performed 
with the same reader.  
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One data source contains the following blocks: 

● Read trigger  

Read triggers are activation mechanisms. They cause the data source to read the data 
from the tags that are located in the field of the four incoming goods antennas. A 
continuous trigger can, for example, be configured that will cause the antennas to read 
constantly.  

● Tag selector  

Tag selectors are mechanisms used to forward data and to filter data. They determine 
which tag data areas should be read or routed on. They also define which tags should be 
supplied or filtered out on the basis of the contents of these data areas. In this case, a tag 
selector orientates itself on the tag ID or the freely parameterizable user data of the tag.  
In this scenario, the tag selector is use to read the recipient of the goods from the user 
data field and to route this information on together with the pallet ID. The user application 
checks, on the basis of the transferred data, whether the correct pallets have been 
delivered. If this is the case, the user application triggers a green signal light in the 
production hall by activating an output of the reader. The stock inventory is also updated.  
If this is a fixed filter criterion, the evaluation and control of the output can occur directly in 
the reader.  

● Smoothing  

Smoothing is a technique that is used to optimize the read quality. The reader marks the 
read event with a status description for the tag (e.g.: detected for the first time by the 
inbound logistics antennas, reliably detected, lost) and adds these states to the read 
results. Time intervals are defined using this technique - for example, how long a tag 
detected for the first time has to be "seen" for it to be regarded as reliably detected. This 
allows tags to be excluded that have been unintentionally detected briefly in the boundary 
areas of the reader.  

Notification channel 
One or more data sources are assigned to one notification channel as data suppliers. A 
notification channel is used in this example to which the data source for the antennas of the 
incoming goods portal has been assigned. The notification channel routes on the data from 
this data source.  

A notification channel contains the following blocks: 

● Notification channel trigger  

Notification channel triggers are activation mechanisms. They cause the notification 
channel to transfer the data from the data source assigned to it. A continuous trigger can, 
for example, be configured that will cause data to be transferred constantly.  

● Data selector  

Data selectors are mechanisms that process tag information and filter it. In this scenario, 
for example, filtering can be performed using smoothing criteria that are defined in the 
data source. Information is only transferred from tags that are in the reliably detected 
state. It can be assumed that these have been detected without errors. 
In general, the data selectors can supply additional information (reader fields). This 
includes, for example, the time of the read.  
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XML interface  
The data of a reader can be made available via the XML interface of the user application. 
The is performed using the following read procedure: 

● Asynchronous read procedure  

Asynchronous read procedure means that a user application logs onto the report of the 
XML interface and automatically receives the data. This continues until the application 
logs off again.  

● Synchronous read procedure  

Synchronous read procedure means that a user application places individual queries to 
the reader using XML commands and receives the desired data immediately.  

2.1.2 Scenario 2: Monitoring incoming goods and outgoing goods 
The scenario comprises an RFID system with two readers. Reader 1 with its four antennas 
monitors the incoming goods portal of a production hall through which pallets are delivered. 
Each pallet is equipped with a tag. The tags contain user data that provide information about 
the sender and receiver of the goods. These data are read out and routed on - in the same 
manner as in the first scenario. The goods supplied on pallets undergo further processing in 
the production hall and subsequently exit the hall through the outgoing goods portal.  

Reader 2 is controlled through light barriers and monitors the two outgoing goods portals that 
are assigned to different recipients with two antennas in each case. Pallets are dispatched 
through the outgoing goods portals. Each pallet is equipped with a tag. These tags also 
contain user data that provide information about the sender and receiver of the goods. The 
data read by the readers are checked to ensure that the pallets are at the correct outgoing 
goods portal. Depending on the read results of the reader, the outgoing portal opens, or it 
remains closed. 
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Figure 2-2 Scenario 2: Monitoring incoming goods and outgoing goods 

The two readers are connected to the RF-MANAGER for configuring and commissioning and 
connected to an user application via an XML interface. The user application receives the 
data of the filtered and sorted tags in the form of reports or by executing XML commands. 
For this example, you must configure the components described below in RF-MANAGER.  
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Diagram in RF-MANAGER 

 

RFID devices  
In this scenario, there are two RFID devices. RFID device 1 is set up as for the RFID device 
of the first scenario - it represents Reader 1, which monitors the incoming goods portal. RFID 
device 2 represents Reader 2, which monitors both outgoing goods portals. 

Antennas  
RFID device 1 contains four antennas for the pallets that pass through the incoming goods 
portal. RFID device 2 contains two antennas each for the pallets that pass through the two 
outgoing goods portals.  

Data source 
For RFID device 1, one data source is sufficient, because only the incoming goods portal is 
monitored. 
In RFID device 2, two data sources are created each with two assigned antennas - one for 
each outgoing goods portal. The two data sources enable two mutually independent tasks 
(separate read procedures for each outbound logistics gate) to be implemented. 
The data sources contain the following blocks:  
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● Read trigger 
In this scenario, a continuous trigger is configured in data source 1. A trigger is 
configured in data sources 2 and 3 that activates the antenna for reading when the 
respective light barrier is interrupted. 

● Tag selector  

In this scenario, the following actions can be performed, for example:  
The tag selector in data source 1 is used to read the recipient of the goods and to pass 
this information on. In the same manner as scenario 1, it orientates itself on the user data 

The tag selectors in data sources 2 and 3 also orientate themselves on the user data and 
the included goods recipient, but they use this information for filtering. That is: When a 
suitable tag is delivered, the user application automatically opens the outgoing goods 
gate by activating one output of the reader. 

If this is a fixed filter criterion, the evaluation and control of the output can occur directly in 
the reader.  

Notification channel  

In this scenario, there are two notification channels: Notification channel 1 refers to data 
source 1 and is a component of RFID device 1.  
Notification channel 2 as a component of RFID device 2 and passes on the data from data 
source 2 or 3. 

The notification channels contain the following blocks: 

● Notification channel trigger 
In this scenario, the following triggering mechanisms can be configured, for example: The 
trigger in notification channel 1 operates continuously. The trigger in notification channel 
2 also operates continuously so that the user system can open the outgoing goods door 
as soon as possible on delivery of a suitable tag. 

● Data selector 
In this scenario, the following filtering procedures can be performed, for example:  
The data selector in notification channel 1 operates in the same manner as in the first 
scenario.  
The data selector in notification channel 2 supplies additional data from the reader fields 
along with the data of the read procedure. This is particularly useful when the loading 
times for pallets has to be monitored. 

XML interface  
In this example, there is an XML interface that queries the data from RFID device 1 
(incoming goods) and a further XML interface, which queries data from RFID device 2 
(outgoing goods). The blocks of the XML interface operate in the same manner as in the first 
scenario. 



 Introduction to the RF-MANAGER 
 2.1 Overview of the RF-MANAGER architecture 

RF-MANAGER Basic V3 
Operating Manual, 09/2012, A5E03125518-03 21 

2.1.3 Scenario 3: Monitoring incoming goods, distribution of good, and outgoing 
goods 

The scenario comprises an RFID system with three readers. Reader 1 with its four antennas 
monitors the incoming goods portal of a production hall through which pallets are delivered. 
Each pallet is equipped with a tag. The tags contain user data that provide information about 
the sender and receiver of the goods. These data are read out and routed on - in the same 
manner as in the first scenario. The goods supplied on pallets undergo further processing in 
the production hall and subsequently exit the hall through the outgoing goods portal. 

Reader 3 is controlled by a light barrier and monitors a conveyor belt using four antennas; 
the conveyor transports the goods towards two output gates that are assigned to different 
recipients. Each item is comes with a tag. These tags also contain user data that provide 
information about the sender and receiver of the goods. There is a separating filter 
downstream of the conveyor that determines the output gate to which the goods should be 
directed. The separating filter is set in accordance with the results from the reader and the 
goods are distributed.  

Downstream of the separating filter, the goods are loaded onto pallets - each pallet is 
marked with a tag. These tags also contain user data that provide information about the 
sender and receiver of the goods. The data read by Reader 2 are checked to ensure that the 
correct pallets are waiting at the outbound logistics gate specific to the recipient. Light 
barriers are installed to control the reader. Depending on the read results of the reader, the 
outgoing portal opens, or it remains closed. 
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Figure 2-3 Scenario 3: Monitoring incoming goods, distribution of good, and outgoing goods  

The reader is connected to the RF-MANAGER for configuring and commissioning and 
connected to an user application via an XML interface. The user application receives the 
data of the tags in the form of reports or by executing XML commands. For this example, you 
must configure the components described below in RF-MANAGER. 
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Diagram in RF-MANAGER 

 

RFID devices   
In this scenario, there are three RFID devices. RFID device 1 represents Reader (1), which 
monitors the incoming goods portal. RFID device 2 represents Reader (2), which monitors 
both outgoing goods portals. RFID device 3 represents Reader (3), which monitors the 
goods distribution conveyor. 

Antennas 
RFID device 1 contains four antennas for the pallets that pass through the incoming goods 
portal. RFID device 2 contains two antennas each for the pallets that pass through the two 
outgoing goods portals.  
RFID device 3 contains four antennas for the items that pass over the goods distribution 
conveyor.    
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Data sources 
For RFID device 1, one data source is sufficient, because it monitors only the inbound 
logistics gate. 

In RFID device 2, two data sources are created, each with two assigned antennas - one for 
each outbound logistics gate.  
A data source for the goods distribution conveyor is created in RFID device 3.  
The data sources contain the following blocks:    

● Read trigger 

In this scenario, a continuous trigger is required for data source 1 that activates the 
antennas for continuous reading. 
In each of data sources 2, 3, and 4, one trigger is configured that activates the antenna 
for reading when the respective light barrier is interrupted.   

● Tag selector 

In this scenario, the following actions can be performed, for example:  
The tag selector in data source 1 is used to read the recipient of the goods and to pass 
this information on. In the same manner as scenario 1, it orientates itself on the user data 

The tag selector in data source 4 also orientates itself on the user data and passes on the 
goods recipient contained within. That is: On the basis of the information, the user 
application or reader must check the output gate for which the goods are destined. 
Depending on the check, the switch point is set from the user application or the reader 
and the goods are destined for the correct output gate. 

The tag selectors in data source 2 and data source 3 filter via the goods recipient 
contained in the user data. It is determined whether the goods that have been directed to 
the correct output gate were also loaded onto the correct pallets. It this is the case, and 
therefore a suitable tag is delivered, the user application or reader automatically opens 
the outgoing goods gate.   

Notification channels    
In this scenario, there are three notification channels: Notification channel 1 refers to data 
source 1 and is a component of RFID device 1.  
Notification channel 2 is a component of RFID device 2 and refers to data source 2 or 3. 

Notification channel 3 refers to data source 4 and is a component of  
RFID device 3. 
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The notification channels contain the following blocks: 

● Notification channel trigger 

In this scenario, the following trigger mechanisms can be configured, for example: The 
trigger in notification channel 1 operates continuously. The triggers in notification 
channels 2 and 3 also act continuously to allow the user application to make the decision 
for the separating filter as soon as possible or to open the goods gate as quickly as 
possible.   

● Data selector  

In this scenario, the following filtering procedures can be carried out, for example:  
The data selector in notification channel 1 operates in the same manner as in the first 
scenario.  
The data selector in notification channel 2 also supplies additional data from the reader 
fields along with the data of the read procedure. This is particularly important when the 
loading times for the pallets are to be monitored. 
The data selectors in notification channel 3 also supplies additional data from the reader 
fields, for example, the name of the reader.   

XML interface    
In this example, there are three separate XML interfaces that query the data from RFID 
device 1 (incoming goods), RFID device 2 (goods distribution), and RFID device 3 (outgoing 
goods). 

The blocks of the XML interface operate in the same manner as in the first scenario. 
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2.1.4 Overview of the RFID functions of the reader 
The following functions are available in the reader and can be used by a user application via 
the XML interface. 

 
Overview of the RFID functions of the reader 
Reading tags 
Writing tags  
Locking tags 
Erasing tag 
Read user data/write user data 
Set output 
Read input/output 
Switching RFID device online/offline 
Initiating trigger 
Transfer of reports/alarms: Log on/log off via an XML interface 

For more information, refer to the "SIMATIC RF Function Manual" manual. 
 

 Note 
Additional system functions 

There are also system functions to set the outputs of the reader, which can run directly in the 
reader without a user application.  
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Installation of the RF-MANAGER Basic 3
3.1 Installing/uninstalling 

3.1.1 Installing RF-MANAGER Basic 

3.1.1.1 System requirements 
 
 RF-MANAGER Basic 
Supported devices  Standard PC  
Operating system • Windows XP Professional, SP3 and higher 

• Windows 7 Professional, SP1 and higher 

CPU at least Pentium IV, 
with 1.6 GHz processor 

Graphic Resolution: 
• at least 1024 x 768 
• recommended 1280 x 1024 
at least 256 colors 

RAM • at least 1.0 GB 
• recommended 2.0 GB 

At least 400 MB Free memory space / 
hard disk In addition to the space needed by RF-MANAGER Basic, Windows also requires space on the 

hard disk, e.g. for the swap file. For additional information, refer to your Windows documentation.
Additional hardware DVD drive (for software installation) 
Reader for document 
display 

Adobe Acrobat Reader 7.0 or higher 

Internet browser Microsoft Internet Explorer V6.0 SP1 / SP2 
Multiple screens The operating system function used to visualize the screen content on several monitors (Control 

Panel > Display > Settings) is not released with RF-MANAGER Basic. 
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3.1.1.2 Installation overview 
If all of these system requirements are met, you can install RF-MANAGER Basic. Then 
install a currently available Service Pack. The currently available Service Pack can be found 
on the Internet (http://www.siemens.com/automation/service&support). 

 

 Note 

The most current available Service Pack contains all previous Service Pack versions. You do 
not have to install all available Service Packs. 

 

NOTICE  
User rights 

Administrator privileges are required for the installation of RF-MANAGER Basic. 

After installation has been completed, you require simple user rights to be able to use RF-
MANAGER Basic under Windows XP / Windows 7. 

 

3.1.1.3 Installation of the RF-MANAGER Basic 

Introduction 
All RF-MANAGER Basic components are installed:   

● RF-MANAGER Basic 

– Help files 

– English and German languages 

Requirement 
Refer to chapter System requirements (Page 27). 

http://www.siemens.com/automation/service&support�
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Procedure 
To install RF-MANAGER Basic, follow these steps: 

1. Start the installation by double-clicking on the file "Setup.exe". 

2. Select the Setup language. 

3. Read and accept the terms of the license agreement. 
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4. Select the desired installation folder. Select the component for this purpose. The 
"Browse" button appears. Select the installation path for these components. 

 
The status of the component is indicated by small icons to its left. You can display more 
information on these symbols by clicking the "Help" button. 

5. Setup requires a restart. After the restart, log on with the same logon used for the 
installation process. 

The system will be reconfigured after you completed the installation. This will take a few 
minutes to complete. 

Result 
The RF-MANAGER Basic V3 has now been installed on your computer. 

In the installation folder, usually "C:\Program Files\Siemens\SIMATIC RF-MANAGER 
Basic\SIMATIC RF-MANAGER Basic V3", you will find the following folder in addition to the 
standard folders: 

● RF-MANAGER Basic V3 Support 

The "RF-MANAGER Basic V3 Support" folder contains a demo application with which you 
can test RF600 reader family with Ethernet interfaces. For more information, refer to the 
"SIMATIC RF Function Manual" manual.  
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Once the installation has completed with no errors, start RF-MANAGER Basic as described 
in the section "Starting RF-MANAGER Basic (Page 33)". 

 

 Note 

Setup also installs the Microsoft MSDE SQL database. For details and information about any 
limitations, visit the Microsoft homepage at "www.microsoft.com". 

When RF-MANAGER Basic is installed, all required components of the operating system 
that are not available yet are installed. After you have installed RF-MANAGER Basic, run 
"Microsoft Windows Update" to check for new security updates. 

 

 

3.1.1.4 Troubleshooting 

Possible errors during Setup and appropriate remedies 
 
Error Cause Remedy Procedure 
Setup will be cancelled with an 
error message.  

Wrong Internet 
Explorer 

Make sure that 
Microsoft Internet 
Explorer Version 6.0 
service pack 1 or higher 
is installed. 

Install the latest version of Microsoft 
Internet Explorer from the homepage 
"www.Microsoft.com". 

The installation will be stopped 
error message 1645 "Error 
Installing Microsoft®.NET 
Framework, Return Code 1601". 

Wrong DCOM 
configuration. 

Check the DCOM 
configuration. 

Go to the Start menu of the operating 
system and select the "Run" command. 
Enter "dcomcnfg.exe" and close the dialog 
with the "OK" button. In the "Default 
properties" tab of the "DCOM Configuration 
Properties" dialog box, do NOT select 
"Default Authentication Level" = "None" 
and "Default Impersonation Level" = 
"Anonymous" at the same time. 

The SQL server of RF-
MANAGER Basic cannot be 
installed. 

The "Autostart 
type" is 
disabled for the 
"Server" service 
on your PC. 

Enable the "Autostart 
type" for the "Server" 
service. This service is 
a prerequisite for 
successful installation. 

 

Setting-up an Internet 
connection 

 Initial starting of RF-MANAGER 
Basic takes a long time.  

A network 
connection is 
configured for a 
user, but not an 
Internet 
connection  

Alternative: 
Disable the "Check for 
publisher's certificate 
revocation" option in 
Internet Explorer.  

The setting is in the Control Panel 
under"Internet Options > Advanced > 
Security". 
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3.1.2 Uninstalling RF-MANAGER Basic 

Introduction 
With RF-MANAGER Basic you can also uninstall all the components. 

Requirement 
● Refer to chapter System requirements (Page 27). 

● RF-MANAGER Basic is installed. 

Procedure 
1. Close all open applications, in particular RF-MANAGER Basic. 

2. Select "Start > Settings > Control Panel" to open the Control Panel. 

3. Double-click "Add or Remove Programs" in the Control Panel. 

This opens the "Add or Remove Program"" dialog box. 

4. In the "Add or Remove Program" dialog, select the following entry and perform the steps 
listed below: 

– "SIMATIC RF-MANAGER Basic V3" to uninstall the RF-MANAGER Basic 

The "Change/Remove" button appears. 

5. Click the "Change/Remove" button. 

The RF-MANAGER InstallShield Wizard appears. 

6. Select the "Remove the Program" option and then click "Next". 

7. Confirm the removal with "OK". 

RF-MANAGER Basic will be removed from the configuration computer. 

8. In the next dialog box, click "Finish" to close the uninstall dialog. 
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3.2 Starting RF-MANAGER Basic 

New entries in the Windows Start menu 
After installing RF-MANAGER Basic, you will find new entries in the Start menu of the 
operating system under "Simatic":   

● The configuration software can be found under the following entry: 

""Start > SIMATIC > RF-MANAGER Basic V3 > RF-MANAGER Basic V3" 

● The online help can be found under the following entry: 

""Start > SIMATIC > RF-MANAGER Basic V3 > RF-MANAGER Basic V3 Help System" 

● The demo application for testing the XML interface can be found under the following 
entry: 

"Start > SIMATIC > RF-MANAGER Basic V3 > RF Reader XML Demo" 

Introduction 
Start RF-MANAGER Basic in the Start menu of the operating system.      

Procedure 
1. In the Start menu, select the "SIMATIC > RF-MANAGER Basic V3 > 

RF-MANAGER Basic V3" command. 

2. A new project is created and standard values are assigned to the reader components. 

3. Adapt the settings to your requirements. 

4. Check the consistency of the project. 

5. Transfer the data to the reader. 

6. Test the functionality with the reader. 

3.3 Configuring RF-MANAGER Basic 

3.3.1 Changing the language 

Introduction 
Set the menu and dialog language of your user interface. You can set up the user interface, 
for example, for English-speaking engineers.      
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Requirement 
The desired user interface language has been installed together with RF-MANAGER. 

Procedure 
1. Select "Settings" from the "Options" menu. 

The "Settings" dialog box is opened. 

2. Click on "User interface language" in the "Workbench" group. 

3. In "Language", select the user interface language you require. 

4. Confirm your entries. 

The dialog box closes. 

3.4 Understanding and optimizing the scanning of RFID tags 

3.4.1 Introduction 

Configuration is easy... 
The configuration tool RF-MANAGER Basic makes it easy for the user to create a 
configuration that enables the RFID tags to be acquired with an RFID device and this 
information can then be supplied via the XML interface to a user application. 

When creating a new configuration when starting RF-MANAGER Basic, the parameters of all 
the involved components are set to a default value. 

This, however, only creates the basis that allows RFID tags to be simply detected. A default 
setting cannot be expected to cover all the possible user scenarios, because these vary 
considerably. Default settings cannot be expected to provide fine-tuning to the specific 
application of each individual customer.  

... Optimization requires system know-how 
To allow various different user scenarios to be covered, it has been ensured that all relevant 
parameters can be changed as required. This is, however, where the challenge begins: On 
the one hand, there is a large number of individual parameters, on the other hand, there are 
special boundary conditions and dependencies between these parameters. The user 
therefore is able to set up a system optimally but if the configuration is incorrect, it may not 
be possible to acquire RFID tags correctly. 

Even though the RF-MANAGER Basic configuration tool protects or warns the user against 
completely wrong entries, a certain flexibility must be maintained to make fine adjustments 
possible.  
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3.4.2 Objectives of this section 
To improve understanding of the possible settings and to enable appropriate values to be 
set, this section will try to provide answers to the following questions:  

● Which components are involved before the data of a transponder has been transferred 
from acquisition through to the end user and how do these components interact? 

● Which parameters of the system should be set? Which are only needed in special cases? 

● Are there dependencies or boundary conditions that have to be observed? 

● Do these conditions change in accordance with the application scenarios? 

● What assistance is available for detecting RFID tags with more certainty? 

● What pitfalls must be avoided? 

The main emphasis here is on the parameters that affect the timing aspects of RFID tag 
acquisition.  

3.4.3 Description of the basics 

The components 
To optimize a system, you need to have an overview of its layout and an understanding of 
how the individual components interoperate. A brief introduction to the main components that 
are involved in the acquisition of tags using RF-MANAGER is therefore provided below. 

 
Figure 3-1 System components of RF-MANAGER Basic 

The figure shows an RFID device (left-hand box) and its connection to an external 
application via the XML interface (right-hand box).    

RFID device   
The RFID device defines the reader and its basic properties. This comprises the addressing 
of the RFID device and the radio profiles and tag protocols that are supported. 

Internally, the RFID device comprises several functional units: 
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Antennas   
The data of a tag must be physically acquired first. This task is performed by the antennas. 
They communicate with the tags through radio waves and acquire the tag data.  

Data source   
The data source collects the tag data from the antennas. A trigger determines the frequency 
at which it requests data.  

The collected data is then compressed in accordance with the smoothing parameter set 
before it is passed on.  

Tag selector   
The additional data of a tag can be optionally defined in the form of tag fields and read in. 
The tag selector not only allows additional data fields to be defined for the purpose of 
passing them on to the XML interface, but also to be filtered in accordance with specific 
values or value ranges so that the volume of tags passed on can be limited. 

Notification channel   
The tag data of a source is collected by the notification channel and filtered, if required, in 
accordance with specific tag events. 

When the trigger of a notification channel is activated, all the collected data is passed on. 

XML interface   
The XML interface is the connection through which the external applications communicate 
with the RFID device. An external application can log onto the RFID device and then receive 
automatically all the read tag data or messages in the reader. It is also possible to launch 
explicit read operations via the external application in the reader using XML commands, and 
thus to control the reader through the application. Other actions such as the use of the digital 
I/O are also possible via XML commands.  
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3.4.4 The journey of the data of an RFID tag through the RF-MANAGER 

3.4.4.1 Work steps for asynchronous automatic tag data transmission 
To establish the times that affect acquisition of a tag, we will be accompanying the data of a 
tag on its journey from the transponder on which it is saved, through the reader components, 
to a user application that then accepts the data from the reader. 

Overview 
So that we won't get lost easily on this journey, we will subdivide the route into separate 
sections as shown in the following diagram. 

 
Figure 3-2 Participating system components and steps in reading an RFID tag 

Why is a picture of the system components shown here again when this has already been 
covered in the preceding section? The difference in this figure lies in the fact that the 
emphasis is on the separate steps, i.e. "what is done". The steps are shown here as white 
boxes and the system components are shown as grey boxes. The red frames a) to d) 
represent the stations that are passed through in sequence.  
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3.4.4.2 Data acquisition 

Context 
To ensure that a reader can operate its antennas autonomously, an RFID device must be 
configured with a data source and an appropriate trigger. When the trigger is released, the 
data source starts acquiring the data. 

This always occurs in so-called read cycles, whereby a read cycle represents one scan of 
the currently active tag by the reader. For this purpose, the data source sends a read 
command to the RFID module and activates with it creation of an inventory. 

The time for an inventory is dynamic. The duration of a read cycle can vary in accordance 
with the number of tags that are currently located in the field or the procedure for collision 
detection.  

There are two ways to perform data acquisition via the data source: 

● Repeated reading 

In repeated reading, the configured number of read cycles is performed per trigger. For 
each read cycle performed, the read data or data sources are reported and can be further 
processed there.  

The duration of the read cycle depends on the tag population and ends after an inventory. 
The maximum time for all read cycles per trigger can be set via a timeout. 

● Bulk reading 

In bulk reading, only one read cycle with the read timeout is performed per trigger. The 
RFID module performs the maximum number of inventories for the read duration. They 
are internally summarized and then reported to the data source. 
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Repeated reading 
The duration of a read cycle is not fixed, so it is not only possible to configure the number of 
read cycles per trigger, but also a read timeout so that at least an upper limit can be set for 
the data acquisition time.       

This time is set in the data source of an RFID device in "Properties > Radio settings > Read 
timeout".  

 

Relationship between the read timeout and read cycle times 
The figure above shows how the read cycles respond to a constant (a) or changing (b) 
number of tags in the field relative to the read timeout. In read cycle 2 of Figure b) there are 
more tags in the field than in read cycle 1 or 3 and therefore the read cycle is longer. 
However, even when there are no tags in the field, a certain basic time is required to address 
the antennas, so that a read cycle does not take less than a specific minimum time 
determined by the hardware.                 

 

 Note 

The read timeout must therefore be greater than the sum of read cycles times, if the tags are 
to be correctly acquired.  

 

 
 

 Note 

An average read cycle time can be assumed for this purpose. 
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Bulk reading 

Application 
"Bulk reading" is available for applications in which tags need to be continuously acquired by 
the RFID module without interruption during a defined time interval.  

Effects 
The RFID module takes inventories continuously for the length of the read timeout that is set 
at the data source of an RFID device in Properties > Radio settings > Read timeout.  

Because the RFID module can only perform one action at a time, other possible read 
requests from other data sources or from commands are delayed. The acquired data are 
delivered to the data source, where they can be further processed, only when the read 
timeout has elapsed. Tags that are acquired multiple times in inventories are only delivered 
once to the data source.  

The difference compared with "repeated reading" is that the repeated reading cycle ends 
after an inventory is taken. If the inventory does not take long, the RFID module is only 
occupied for a short time, and actions can be performed almost in parallel. In bulk reading, 
the RFID module is practically blocked and further actions are delayed. 

 

 Note 
Exceeding the read timeout 

The read timeout can be slightly exceeded, as a started inventory is not canceled. At least 
one inventory is carried out. 

If the values for the read timeout are large, the smoothing values may need to be adjusted 
(see Smoothing / event generation (Page 43)). 

Note that a tag that has been read is only delivered once per read cycle. 
 

 
Figure 3-3 Effects of the read timeout on the read cycle time 
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More than one data source 
If the setting "Asynchronous reader mode" is not activated in "RFID device > Properties > 
System", you can assign more than one data source to one RFID device. 

This means that you can perform two different tasks with a single RFID device.  

For example, for an RFID device with four antennas, you can specify that two antennas are 
assigned to each data source.     

Time sequence 
However, a new time effect appears here that we have to consider. Refer to the figure below 
that shows the time sequence of tag acquisition by an RFID device with two data sources. 

When a data source is created, it is simply a new logical unit for data acquisition that is 
created. As there is only a single item of hardware, namely the RFID module complete with 
its antennas, the hardware can only process one data request. For this reason, when several 
data sources are configured on one RFID device, they are always processed in sequence. 
Processing of the next data source will not start until processing of the previous one has 
been completed. When all the data sources of an RFID device have been completed, 
processing starts with the first one again. 

This results in dead times during which the data source must wait until it is assigned to the 
hardware again (shown in the diagram below by the arrows in broken lines).    

 
Figure 3-4 Acquisition of tags with two data sources on one RFID device     
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 Note 

The total time of a cycle for an RFID device is therefore always the sum of the times of the 
individual data sources. 

 

 
 

 Note 

Each data source has a dead time during which it must wait for assignment of the hardware 
and which comprises the sum of the cycle times of the remaining data sources.  

 

Other influences on the acquisition times 
Apart from the points already mentioned, other factors influence the acquisition times of tags. 
Many of these are specific to the selected tag protocol.  

For example, the communication method selected for the EPC Class 1 Gen 2 protocol 
affects the speed at which tags can be read. If there are a large number of tags in the field, 
the parameter Initial-Q has a significant influence in the case of EPC Class 1 Gen 2 protocol. 

Factors such as frequency hopping or antenna switching can also result in longer delay 
times in the response of the hardware. 

To optimize these parameters settings, extensive knowledge of the respective protocol is 
necessary which exceeds the scope of this documentation. Further details can be found in 
the relevant specifications (see References).  
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3.4.4.3 Smoothing / event generation 

Acquisition cycle of a data source 
Before we consider setting the times for smoothing, it should be explained what is 
understood under the term "smoothing".     

At the end of every read cycle, the data acquisition supplies the information "Tag detected" 
or "Tag not detected" for every tag. This quickly results in an extremely large volume of data. 
The diagram below shows the poll cycle of a data source with the parameterization of 10 
read cycles per trigger. An X within a read cycle represents the status "Tag detected in field", 
an empty read cycle represents the status "No tag in field" or "Tag not detected". In the 
scenario depicted in this diagram, the information "Tag X detected" was generated seven 
times.  

 

X X X X XXX

 
Figure 3-5 Information supplied regarding RFID tags for each read cycle 

Reducing the data avalanche 

Smoothing 
A flood of information of this type is usually undesirable. It is important to know when the 
status of a tag changes, i.e. when a tag has been newly detected or can no longer be 
detected.  

Smoothing reduces the volume of data in this manner. This subsystem notes the information 
about the status of every tag and updates this status information at the end of every read 
cycle.   

X X X X XXX

Tag status

 
Figure 3-6 Reducing the volume of data through tag events 
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Tag events 
Events are generated in accordance with the change in status. The following diagram shows 
the scenario from the figure above again. Without smoothing, the information "Tag detected" 
would be supplied seven times. If information is only supplied now concerning the transition 
of a tag from "previously unknown" to "the tag is now detected" and from "was still detected 
in the last read cycle" to "tag is no longer detected", only two events will be generated now.        

The initial status of a tag "not yet detected" is termed "Unknown". The status "seen in current 
cycle" is termed "Glimpsed" and the status "no longer visible, but was seen previously" is 
termed "Lost".  

The data source must manage the status information of every tag separately so that the 
events can be generated for each tag as shown in the diagram below. 

XX X X X X

Y Y Y Y Y

X

Y

 
Figure 3-7 Tag events for more than one tag 
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Real RFID tags - not always visible 

Gaps in the read cycle 
When working with RFID tags, due to the properties of electromagnetic fields and the objects 
to be identified, it cannot unfortunately be guaranteed that all tags in the field will actually be 
detected in every read cycle. Gaps can often occur in which a tag is not detected. If 
countermeasures are not implemented, tag events are generated as shown in the diagram 
below. 

X X X XXX

 
Figure 3-8 Tag events during acquisition of real tags 

Observed status   
To prevent Glimpsed and Lost events from being continuously generated, an additional 
status of "Observed" in the context of "detected continuously over the long-term" has been 
defined. Also, some timeout and threshold values have been included that can be used to 
eliminate short-term gaps in the acquisition. 

The diagram below shows the new "Observed" status that will only occur after a certain time 
has elapsed (after the threshold for Observed status) and also shows that this status will only 
be exited when a certain time span - the Observed timeout - has elapsed since a tag was 
seen for the last time (Observed Timeout 3 in the diagram below). 

If the tag is detected again at the end of a read cycle, the Observed timeout will be started 
again (transition from Observed Timeout 1 to 2 and from 2 to 3 in the diagram below). 

X X X XXX

 
Figure 3-9 Elimination of "temporary failures" in tag acquisition 
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NOTICE  
To smooth out "temporary failures", the Observed timeout must always be longer than a 
read cycle. A length of at least two read cycles is recommended. 

 

When is a tag "Glimpsed" and when is it "Observed"? 
By setting the Observed timeout, temporary "gaps" in tag acquisition can be eliminated as 
shown in the diagram above. But how can we handle the brief flickering of a tag? 

Threshold for Observed status  
The threshold for Observed status is used to specify the interval between initial detection of 
a tag and changeover to Observed status. This change in status is independent of the 
current acquisition status. This would however mean that the Observed status could be 
caused by a brief flicker of a tag (see left of diagram below) as well as by continuous 
detection of a tag (see right of diagram below). 

X X X X X

Tag status X

 
Figure 3-10 Brief "flickering" of a tag without a Glimpsed timeout 

Glimpsed timeout  
In most cases, however, a distinction has to be made between these two scenarios so that 
temporary interference can be suppressed. Another time constant, the Glimpsed timeout, 
exists for this purpose that is always reactivated when a tag was last detected in the 
Glimpsed status. 

If the Glimpsed timeout elapses, the status of the tag changes again from Glimpsed to 
Unknown (see Glimpsed Timeout 1 in Figure a) and an Unknown event is triggered. 

Every time the tag is detected at the end of a read cycle, the Glimpsed timeout is restarted 
(cf. Figure a, Glimpsed Timeout 2 to 3, 3 to 4). The Unknown event will not be triggered until 
the Glimpsed timeout has elapsed (cf. Figure a, Glimpsed Timeout 4).  
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Tag status

Tag status

X X XX X X XX X

X X XX

 
Figure 3-11 Transitions from Glimpsed status to Observed or Unknown 

Figure b above shows the relation between the Glimpsed timeout and the threshold for 
Observed status. The Glimpsed timeout is only taken into consideration until the threshold 
for Observed status elapses. When the threshold for Observed elapses, the tag switches to 
Observed status and can then no longer return to Unknown status. 

In other words, the Observed threshold can also be interpreted as an interval during which 
Glimpsed timeout monitoring takes place. 

 

 Note 

We have already seen that a Glimpsed timeout is only appropriate if it has a lower value than 
the threshold for Observed status. Otherwise, a transition to Observed status will always 
occur and the qualitative distinction between Glimpsed and Observed is lost. 

 

 Note 

Furthermore, the Glimpsed timeout must always be larger than the duration of the read 
cycle. If the Glimpsed timeout is smaller than a read cycle, the Glimpsed timeout can never 
be reset as a result of the tag being read again.  
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 Note 

To obtain an appropriate qualitative distinction between the Glimpsed and Observed states, 
the threshold for Observed must comprise at least two read cycles. 

 

 Note 

If a distinction between Glimpsed and Observed is not necessary, the threshold for 
Observed status can also be set to 0. An Observed event will then be generated 
simultaneously with every Glimpsed event.  

 

What if a tag disappears again? 

Purged event 
To round off the status model for smoothing, we must consider what happens after a tag 
enters the Lost state. As can be seen from the following diagram, the Lost timeout starts 
when the Lost state is entered. When the Lost timeout expires without the tag having been 
seen again, the tag returns to Unknown status whereby a Purged event is triggered (see 
Lost Timeout 1 in the diagram below).  

This is used to detect whether Unknown status was achieved from Glimpsed status or Lost 
status. 

If the tag is seen again before the Lost timeout elapses, it transfers directly to Glimpsed 
status and the Purged event is not created (see Lost Timeout 2 in the diagram below).  

X X X XX

Tag status X

 
Figure 3-12 Transitions from Lost status to Glimpsed status or Unknown 

Overview of all tag statuses and events 
In a similar manner to the distinction between Unknown status having been achieved from 
Glimpsed (Unknown event) or from Lost (Purged event), a distinction is also made 
concerning entering Glimpsed status.  

A Glimpsed event will always be triggered regardless of the state from which Glimpsed 
status was entered. If the transition takes place from Unknown status, a New event will also 
be generated. 
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Tag status, tag events and tag times    
To conclude this topic, let us summarize all the states, events and times. The following the 
graphic illustrates the four states of a tag: Unknown, Glimpsed, Observed and Lost. The 
possible transitions are indicated by arrows, whereby the time condition for the status 
transition is shown in square brackets in each case and the event triggered on status change 
is shown with an arrow. 

 
Figure 3-13 Status transitions, events and times for tags 

All the specified times for timeouts and thresholds can be configured in RF-MANAGER for 
the RFID device in Source > Smoothing. 

More than one data source per RFID device on smoothing 
As already explained above, several data sources on one RFID device can only be 
processed sequentially (see the diagram below).  

When other data sources are being acquired, a data source is unable to process read cycles 
and to detect new tag states. 

 
Figure 3-14 Activity and wait states of more than one data source on an RFID device 
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Despite this, all the time values such as the threshold for Observed continue to run as well 
as all timeouts. This must be taken into account when the time values are specified, 
otherwise smoothing would only function when a data source was currently active and it 
would deliver "false" states when this data source was inactive. 

 

 Note 

When more than one data source exists for a device, the times for smoothing must be 
selected such that they always take into account the inactive time of a data source.  

 

Does the trigger of the data source have any effect? 
The short answer to this question is yes.  

For a more detailed answer, we must consider again what actually happens in the smoothing 
system: The status of each individual tag is managed and updated at the end of every read 
cycle depending on whether a tag has been detected or not. 

This, of course, will only work as long as the smoothing stage of the data source receives 
new information from the executed read cycles. As soon as data acquisition stops, the status 
model will become out-of-date and therefore invalid. 

As long as the data source is continuously triggered, there will not be a problem, because 
the status of the tags will always be up-to-date. In other scenarios, however, it may only be 
necessary to acquire data when a light barrier is triggered, so a trigger need only be 
configured on the I/O edge. 

If you are only interested in whether a specific tag is present, the duration of the poll cycle or 
the number of read cycles can be relatively small. If, however, you not only want to detect 
the appearance of the tag but also its disappearance, you must ensure that the read timeout 
and the number of read cycles per trigger are not selected too small so that the status model 
for the tags is executed correctly. 

The number of read cycles that must be executed so that all states can be appropriately 
acquired depends on the one hand on the speed at which the tags move through the field 
and on the other hand on how the acquisition time of the data source is specified using 
parameters such as the read timeout.  

3.4.4.4 Who do I let know? 

The notification channel 

Function  
After the data has been acquired and the volume of information has been reduced to an 
amount that can be reasonably processed by smoothing, the remaining events are 
transferred to the notification channel. 

Here, depending on the settings of the data selector, tag events will be filtered out if the 
associated event filter is not selected. The default setting here is that only events of the 
types Observed and Lost will be processed further.  
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All the events that occur that are not filtered out are stored temporarily in a notification buffer. 
When the trigger for the notification channel is activated, the current contents of the 
notification buffer is transferred.  

In contrast to the smoothing stage of the data source, triggering of the notification channel is 
not critical because the data is internally buffered and no states have to be updated. 

Despite this, the notification channel manages a status to determine whether new tags have 
arrived or active tags have disappeared. Correct functioning of this management requires 
that: 

 

 Note 

At least one of the event filters New, Glimpsed and Observed and one of the event filters 
Lost, Unknown and Purged must be active for all reports to function correctly.  

 

3.4.4.5 XML interface 
The XML interface is the connection between the reader-internal functional units and the 
external application. The data of the notification channel are summarized in reports and sent 
to an external application that has logged on to this reader. Mechanisms with response 
acknowledgment are available to ensure secure data transmission.  

XML commands 
In addition to automatically providing tag data or reader messages, XML commands are 
available to an external application, e.g. to send explicit read commands to the reader. 
These additional read commands can affect the timing behavior of the automatic tag 
detection due to the processing times resulting from the data sources.  

3.4.4.6 Conclusion 
With the creation of reports and their transfer to external applications, the journey of the tag 
data through the RFID device ends. The acquired and filtered data leave the system and 
disappear from its sphere of influence. 

For further information on the subject of optimization of tag acquisition, see the following 
literature: (available at http://www.epcglobalinc.org/standards) 

● /EPC_RP/ EPCglobal. Reader Protocol Standard 1.1, Ratified Standard, June 21, 2006. 

● /EPC_RM/ EPCglobal. Reader Management 1.0. Ratified Standard, December 05, 2006. 

● /EPC_ALE/ EPCglobal. The Application Level Events (ALE) Specification, Version 1.0. 
Ratified Specification, September 15, 2005. 

● /EPC_TD/ EPCglobal. EPC Generation 1 Tag Data Standards Version 1.3 Ratified 
Specification, March 8, 2006. 

● /EPC_TDT/ EPCglobal. Tag Data Translation (TDT) 1.0. Ratified Standard, January 21, 
2006. 
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Working with RF-MANAGER Basic 4
4.1 RF-MANAGER Engineering System 

RF-MANAGER Basic is the software for future oriented RFID concepts using easy and 
efficient engineering.  

To start RF-MANAGER Basic, either click the desktop icon on the programming device or 
select it from the Windows Start menu.  

 
In RF-MANAGER Basic, you can only ever have one project open. Start RF-MANAGER 
Basic more than once to work on several projects simultaneously.  

4.1.1 Program desktop 

4.1.1.1 Desktop elements 

Introduction 
The working environment of the RF-MANAGER Basic comprises several elements. Some of 
the elements are linked to specific editors which means they are not visible unless the 
corresponding editor is active. 

Elements of RF-MANAGER Basic 
You can access all the functions provided by RF-MANAGER Basic by means of its menus 
and toolbars. When the mouse pointer is moved over a function, a ToolTip appears. 

The RF-MANAGER Basic comprises the following elements: 
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Elements of RF-MANAGER Basic 

 
1 Menus and toolbars The menus and toolbars provide access to all functions you need to configure your reader. 

When the mouse pointer is moved over a command, the corresponding ToolTip appears. 
2 Workplace Project objects are edited in the workplace. All RF-MANAGER elements are arranged on 

the borders of the workplace.  
3 Property view The property view is used to edit object properties, e.g. the performance settings of 

antennas. 
4 Output window The output window displays system alarms generated, for example, in a project test run. 
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4.1.1.2 Menus and toolbars 

Introduction 
The menus and toolbars provide access to all functions you need to configure your reader. 
When the corresponding editor is activated, menu commands and toolbars specific to that 
editor appear.   

When the mouse pointer is moved over a command, the corresponding ToolTip appears. 

 

Menus 
The following menus are available in RF-MANAGER Basic:   

 
Menu Short description 
Project Contains commands for project management. 
Edit Contains commands for clipboard functions. 
Readers Contains commands to configure the reader, such as "Configure Reader", 

"Transfer to Reader", etc. 
View Contains functions to start the reader's diagnosis view. 
Extras Contains commands to change the RF-MANAGER Basic interface language.   
Help Contains commands for calling help functions. 

The availability of the menus and the scope of their commands depend on the respective 
editor which is used. 

Toolbars 
The toolbars provide quick access to important, frequently used functions. You can move 
each toolbar to suit your purposes. 
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4.1.1.3 Workplace 

Introduction 
Project data is processed in the workplace in table form.  

 

Description 
Each component of the reader is opened in a separate tab on the workplace. There is only 
one tab active at a time. To change to a different reader component, click the corresponding 
tab.  

4.1.1.4 Properties view 

Introduction 
The property view is used to edit the properties of an object selected from the workplace. 
The content of the property view is based on the selected object.  

 

Description 
The property view shows the properties of the selected object organized in categories. The 
changed values take effect directly after exiting from the input field.  

If you enter an invalid value, this is highlighted in color and you can correct this input error. 
QuickInfo provides you with information on the valid value range, for example 
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4.1.1.5 Output View 

Introduction 
The output window displays system alarms generated, for example, in a project test run.  

 

Description 
The output window normally displays system alarms in the order they occur. The categories 
define the corresponding RF-MANAGER module which has generated a system alarm. 
System messages of the "Generator" category are generated, for example, during the 
consistency check.  

To sort system alarms, click the header of the corresponding column. The pop-up menu can 
be used to jump to an error location or a variable, and copy or delete system alarms.  

The output window shows all system alarms of the last action. A new action overwrites all 
previous system alarms. 

4.1.1.6 Input fields 
 

 

 Note 
Special characters in input fields of the RF-MANAGER Basic 

The following special characters may not be used in the input fields of the RF-MANAGER 
Basic: 
< > & „ " ’ 

 

4.1.2 Switching between reader components 

Tabs 
To select a different component, click the relevant tab in the workplace. A tab shows the 
name of the component for easy identification.  
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4.1.3 Displaying Help 

Shortcut help 
A tooltip will appear after moving the mouse pointer over any object, icon, or dialog element.     

 
A question mark next to the tooltip indicates that a shortcut help is available for this user 
interface element. To call up a more detailed explanation in addition to the short description, 
click on the question mark, press <F1> if the tooltip is activated, or move the mouse cursor 
to the tooltip. 

The explanation includes references which refer users to a detailed description in the Online 
Help.  

Online help 
In the "Help" menu you can access the online help. When you use the "Help > Contents" 
menu command, the RF-MANAGER Basic Information System opens and displays a table of 
contents. Use the table of contents to navigate to the desired topic. 

As an alternative, select the "Help > Index" menu command. The RF-MANAGER Basic 
Information System opens with an opened index. Use the index to search for the desired 
topic. 

In order to use the full text search throughout the entire RF-MANAGER Basic Information 
System select the "Help > Search" menu command. The RF-MANAGER Basic Information 
System opens with an opened search register. Enter the desired search term.    

The RF-MANAGER Basic Information System can also be opened via the Start menu in 
Windows. Select the menu command "Start > SIMATIC > RF-MANAGER Basic V3 > RF-
MANAGER Basic V3 Help System" in the taskbar. 

The Online Help system is opened in a separate window.  
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4.2 Working with projects 

4.2.1 Basics 

4.2.1.1 Configuration data 
You can configure a maximum of one reader in an RF-MANAGER project. 

A project in RF-MANAGER contains all your configuration data.  
Configuration data includes: 

● Network address settings 

● Performance of the antennas 

● Values for filters 

All data related to a project is stored in the database integrated in RF-MANAGER. 

Opening multiple sessions of an RF-MANAGER project 
An RF-MANAGER project should not be opened in multiple sessions. This applies in 
particular to the opening of projects on network drives.  

4.2.1.2 Components of a project 
An RF-MANAGER project consists of all the data that the device requires. 

The configuration data is compiled in RF-MANAGER according to topic categories. Each 
category is processed in an individual editor.  

If you want to archive the project, it is sufficient to back up the files [ProjectName].rfidb and 
[ProjectName]_log.ldf. All other files can be created as required. 
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4.2.2 Multilanguage configuration 

Multilingual RF-MANAGER user interface 
The language of the user interface in RF-MANAGER can be selected, for example, to suit 
regional requirements of several engineers of different nationality working with the RF-
MANAGER. Languages are selected in: 
"Options > Settings > Workbench > User interface language".    

Switching the Online Help language 
If the Online Help system crashes when changing languages, check the version of the 
"hhctrl.ocx" file in the "system32" subdirectory of the installation directory of the operating 
system. If the file version is older than V5.2.3735.0, download a newer version from 
"http://msdn.microsoft.com/library".  

4.2.3 Editing an existing project 
If projects were created with a previous version of the RF-MANAGER Basic, these can be 
further edited following automatic conversion with the RF-MANAGER Basic. You will find 
more detailed information in the section "Converting projects (Page 73)". 

4.2.4 Creating a project 

4.2.4.1 Introduction 
The following chapters describe the procedure in detail for creating a new RF-MANAGER 
project. 
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4.2.4.2 Create a project 
After you have started the RF-MANAGER Basic, you can select the following options: 

● Open the most recently edited project 

● Open an existing project 

● Create an empty project 

 
If you create a new empty project, select the relevant project data from the following drop-
down lists: 

● Country in which the system will be operated 

● Reader type, e.g. SIMATIC RF640R or RF670R 

● Wireless profile, e.g. ETSI (Europe) 
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4.2.4.3 Requirements for operating a project with a reader 

Overview 
If you want to operate a project with a reader, the following requirements must be fulfilled: 

● At least one reader is connected to the PC. 

● The reader must have communications capability. 
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Connecting stationary readers and assigning parameters 
You have the following options for connecting a reader of the RF600 series to your 
parameterization computer via Ethernet:    

● Ethernet connection (10/100 Mbit/s) via RJ45 cable, either over an Ethernet network 
(connection via hubs or switches) or as a point-to-point link using a crosslink cable 
directly between a PC and a reader. 

 
Figure 4-1 Overview of configuration of the RF670R reader 
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Figure 4-2 Overview of the RF640R reader configuration 

Connecting the stationary reader to the parameterization computer over Ethernet    
 
Procedure  
1 Disconnect the reader from the power supply. 
2 Connect the Ethernet interface of the reader to the hub/switch to which your parameterization 

computer is also connected over an RJ45 cable. It is strongly advised that you use the accessory 
cables approved by Siemens for each reader. 
When using RJ45 cables from other manufacturers, there is a risk that the cable will be difficult to 
remove from the socket of the reader.  
For PnP connections, a crosslink cable must be used if the network card in the PC does not 
support autocrossover. 

3 Connect the reader to the power supply. 
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Providing the reader with communications capability 
1. In the "Reader" menu, select the command "Set Reader IP Address". 

2. If the reader has not been pre-parameterized, use the Start Discovery button to activate 
the automatic reader search function in the application. 

All readers connected via Ethernet will be shown in the list. 

Note that the network card you have used to connect the reader is selected under the 
network address. 

  Note 

All RF670 readers with version AX are only displayed if they are located in the same 
subnet. 

All RF640R and RF670R readers as of version BX are displayed even if they are not 
located in the same subnet. 

3. Select the desired reader. 
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4. Click the button "Use Reader Address" to adopt the IP address in the "IP Settings". 

5. In the "IP Settings" menu, you can now set new Ethernet parameters for the reader. 
These include: 

– The IP address, 

– The subnet mask 

– The IP address of the gateway 

Click the "Set Reader IP Address" button to transfer the new settings to the reader. 
Alternatively, DHCP can also be set. 

   

NOTICE  
 

Reader cannot be found 

Make sure that the DHCP server is running and the reader is entered in the list. 
Otherwise RF-MANAGER Basic will be unable to establish a connection to the reader. 

If a reader is operating in DHCP mode and there is no DHCP server, the reader can 
neither be found nor displayed using the "Start Discovery" button. 

Before the reader can be addressed, it must be reset to the default settings. See also 
section "Use of DHCP (Dynamic Host Configuration Protocol) (Page 67)". 

NOTICE  
 

Deactivate firewall 

If you want to parameterize a reader of the RF600 family over Ethernet, deactivate your 
firewall before communication starts between the parameterization computer and the 
reader. Otherwise, it may not be possible to connect. 

NOTICE  
 

Avoid simultaneous Ethernet access to readers 

The applications RF-Manager Basic and RF-Manager 2008 cannot simultaneously 
access the same reader of the RF600 family via Ethernet. 

Only start applications that are currently required.  

Make sure that all RF-Manager 2008 Runtime components are deactivated. 

  Note 
For more information on DHCP 

See section "Use of DHCP (Dynamic Host Configuration Protocol) (Page 67)". 
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Use of DHCP (Dynamic Host Configuration Protocol) 

Introduction 
A DHCP server ensures that IP addresses are automatically assigned to DHCP-capable 
network clients in a network segment. The DHCP server uses the MAC address of the 
network client for this purpose. The IP addresses are assigned due to permanent 
assignment of a MAC address to an IP address. The readers of the RF600 family with 
Ethernet connection are DHCP-capable. 
Mechanisms that extend beyond this, such as dynamic assignment of IP addresses or 
Domain Name Service (DNS), are not supported. 

Requirements for activating DHCP 
A DHCP server must be present in the network segment. 

An up-to-date list of permanent assignments between MAC addresses and IP addresses 
must be stored in the DHCP server. This list must be maintained by your responsible IT staff 
member. 

You will find the MAC addresses of readers: 

● on the enclosure next to the RJ45 socket 

  Note 

Ensure that the DHCP server is running and the reader is entered in the list. Otherwise 
RF-MANAGER Basic will be unable to establish a connection to the reader following 
activation. 

 

Enabling DHCP 
The RF600 reader can be switched over to DHCP mode using the Configure Reader menu 
item in RF-MANAGER Basic. 

Procedure 
1. Connect the reader that should be switched over to DHCP mode to the parameterization 

computer via the Ethernet interface. 

2. In the "Reader" menu, select the command "Configure Reader" and click the "DHCP" 
option to enable it. 

The DHCP mode is activated for the selected reader. 

3. Click the "Set Reader IP Address" button. 

The new settings are transferred to the reader. 

4. Disconnect the Ethernet connection between the reader and the parameterization 
computer again. 
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Disabling DHCP  
The DHCP mode can be disabled for the RF600 reader using the Configure Reader menu 
item in RF-MANAGER Basic. 

Procedure 
1. Connect the reader for which DHCP mode should be disabled to the parameterization 

computer via the Ethernet interface. 

2. In the "Reader" menu, select the "Configure Reader" command and click the "DHCP" 
option to disable it. 

The DHCP mode is deactivated for the selected reader. 

3. Click the "Set Reader IP Address" button. 

The new settings are transferred to the reader. 

4. Disconnect the Ethernet connection between the reader and the parameterization 
computer again. 

Restoring default settings on a DHCP reader 
If DHCP is activated on a reader but no DHCP server is available, no connection can be 
made to that reader because it does not have an IP address.  

Procedure 
To assign the reader a new unambiguous IP address, proceed as follows: 

1. Disconnect the affected reader from the network and connect it point-to-point with the 
configuration computer. 

2. In the "Reader" menu, select the command "Set Reader IP Address". 

3. Click the "Reset DHCP Readers" button. 

The reader is reset to the default IP address and DHCP is deactivated.  
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4. Assign a new unique IP address to the reader. 

5. Disconnect the reader from the parameterization computer and reconnect it to the 
network. 

  Note 
Several readers with identical IP address 

It is recommended that the affected reader is disconnected from the network and 
connected point-to-point with the configuration computer. 

If the reader remains in the network, all DHCP readers in the network are restored to their 
default settings and thus have identical IP addresses, because the "Reset DHCP 
Readers" button works on all DHCP readers in the network simultaneously. 

You must then disconnect all DHCP readers from the network, connect each point-to-
point with the configuration computer, and successively assign each DHCP reader an 
unambiguous new IP address. 

Result 
The reader has an unambiguous IP address and can be addressed via the network, e.g. to 
make settings. 

Resetting to the reader to the default settings 
If a reader has an unknown network configuration and can no longer be located, it is possible 
to reset the reader to its basic settings. 

Procedure 
To assign the default IP address to the reader, follow the steps below: 

1. Disconnect the relevant reader from the network and connect it point-to-point with the 
configuration computer. 

2. In the "Reader" menu, select the command "Set Reader IP Address". 

3. Click the "Reset RF600" button. 

The reader is reset to the default IP address and DHCP is deactivated.  
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4. Assign a new unique IP address to the reader. 

5. Disconnect the reader from the configuration computer and reconnect it to the network. 

NOTICE  
 

Several readers with identical IP address 

It is advisable to disconnect the relevant reader from the network and to connected it 
point-to-point with the configuration computer before you click the "Reset RF600". 

If the reader remains in the network, all readers in the network are reset to their default 
settings and therefore have identical IP addresses, because the "Reset RF600" button 
applies to all readers in the network. 

To avoid this, disconnect all readers from the network, connect each one point-to-point 
with the configuration computer and assign each reader a unique new IP address one 
after the other. 

Result 
The reader has a unique IP address and can be addressed via the network, e.g. to make 
settings. 

4.2.5 Project organization 

4.2.5.1 Save project 
Changes made in a project are only accepted after you save these. If the project is closed 
without saving it, any changes made are discarded. A warning appears in this case.    

When a project is saved, all changes are written to the project file. The project file is stored in 
the Windows file system with the extension "*.rfidb". 

The storage time is dependent on the duration of configuration. To keep the storage time 
down, save your project at regular intervals. 

Procedure 
1. Select the "Save" command in the "Project" menu to save the project. 

When the project is saved for the first time, the "Save as" dialog opens. 

2. Select a drive and directory and then enter a name for the project. 

Alternative procedure 

1. Select the "Save as" command in the "Project" menu to save the project under a new 
name. 

2. Select a drive and directory and then enter a name for the project. 
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Result 
The project is saved as a *.rfidb file.   

4.2.5.2 Exit project 
When you have finished processing a project and have saved the changes, you can close 
the project. You can also close the project without saving your changes if you want to reject 
the changes. A warning will then appear that prompts you to save the project.    

Procedure 
1. Select the "Exit" command in the "Project" menu to close the project. 

If you have not saved your changes, a warning appears. 

Result 
The project is closed and the RF-Manager is ended. 

4.2.5.3 Open project 
You can store the project files of RF-MANAGER in a directory of your choice. Project files of 
the RF-MANAGER Basic have the file extension "*.rfidb". To process an existing project, 
open the corresponding file:    

In RF-MANAGER, you can only have one project open. You must start RF-MANAGER Basic 
again for each additional project that want to edit at the same time. 

If you open an existing project, a project that is already open will be automatically closed. 
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Procedure 
1. Select the "Open" command from the "Project" menu. 

The "Open an existing project" dialog box opens. 

 
2. Define the path under which the project is saved. 

3. Select the project. 

Projects have the file extension "*.rfidb". 

4. Click on the "Open" button. 

The Project View opens. 

4.2.5.4 Managing projects in Windows Explorer 

Introduction 
When a project is saved, RF-MANAGER creates a project database on the hard disk. The 
project database is stored in the Windows file system with the extension "*.rfidb". A log file 
(*._log.ldf) is stored for each project database. The consistency of the data cannot be 
guaranteed without this log file.             

The project database can be moved, copied and deleted together with the corresponding log 
file in the Windows Explorer, as you are used to with other files. However, ensure that the 
database and the log file are not separated from each other during copying and moving.  

When you generate a project, additional files are created.  
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Requirement 
The project is closed.  

Procedure 
1. Open Windows Explorer. 

2. Execute the required file operation, e.g. move, copy or delete, on the project database. 

  Note 

The "SQL Server IIDEXPRESS" manages all objects in RF-MANAGER during 
configuration. When a project is closed, it is possible that the objects are still being 
referenced by the "SQL Server IIDEXPRESS". If a project database cannot be moved, 
copied or deleted although the project is closed, you will need to stop the "SQL Server 
IIDEXPRESS".  

To do this open "Manage" by right-clicking on "My Computer" in Windows Explorer. 
Under the "Services and Applications" tab on the left-hand side of the window that opens, 
select "Services". On the right-hand side, select the service "SQL Server IIDEXPRESS" 
and then select "Stop" from the options that appear on the left. The "SQL Server 
IIDEXPRESS" needs to be restarted after you copy, delete or move the project database.

Filing the project data on the network drive 
Network problems appearing at the time you close a RF-MANAGER project you opened 
directly on a network drive may cause data loss when you close the RF-MANAGER session. 
If it is necessary to file the projects on a network drive, the projects should be copied to a 
local drive for editing and then, after closing RF-MANAGER, they can be copied to the 
network drive again. 

4.2.5.5 Converting projects 

Projects of different RF-MANAGER Basic versions 

Introduction 
RF-MANAGER Basic automatically converts projects that were created with an earlier 
product version of RF-MANAGER Basic to the current version. This functionality enables you 
to edit projects that were created with an earlier version using the current RF-MANAGER 
Basic version.  

The system automatically converts a project from an earlier version of RF-MANAGER Basic 
to the current version when the project is opened. 
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Converting a project to the current RF-MANAGER Basic version 

Introduction 
RF-MANAGER Basic allows you to convert projects that were created with an earlier product 
version to the current version. 

Due to the extended functionality of the readers, the configured systems require an updated 
firmware version.  

Converting an RF-MANAGER Basic project from an earlier version 
When you open a project from an earlier RF-MANAGER Basic version with the current 
version of RF-MANAGER Basic, the project is automatically converted. A backup copy of the 
old project is created prior to conversion. The project is automatically saved and 
defragmented by the system when the conversion is completed. When the project is 
defragmented, the project data distributed in the database is combined, rearranged and 
saved. This reduces the project size. If, after saving, you want to work with the original 
project version later, you have to use the backup copy.  

Requirements 
● You have a project that was created with an earlier version of RF-MANAGER Basic. 

● The current version of RF-MANAGER Basic is open. 

Procedure 
1. Select the "Open" command from the "Project" menu. 

The "Open" dialog is displayed. 

2. Go the storage location in the file system where the project from the earlier RF-
MANAGER Basic version is saved and select the project. 

Projects have the file extension "*.rfidb". 

3. Click on the "Open" button. 

A warning will appear prompting you to confirm or cancel the conversion. 

4. To confirm, click the "OK" button in the warning message. 

The system now saves the backup copy of the project to the same folder and converts it 
to the current version of RF-MANAGER Basic. 

Result 
The project has been converted to the current RF-MANAGER Basic version. The readers in 
these projects should be upgraded to the new firmware version if needed. 
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4.2.6 Transferring projects 

4.2.6.1 Requirements for transfer/back transfer 
Before the transfer or back transfer can occur, the relevant reader must be selected. 

The following two scenarios are possible: 

● The IP address of the reader is known 

● The IP address of the reader is not known 

The IP address of the reader is known 
To select the relevant reader, proceed as follows:  

1. In the "Reader" menu, select the command "Set Reader IP Address". 

The "Communication Settings" dialog opens. 

2. Enter the IP address of the relevant reader in the "IP address" input box. 

3. Click "OK". 

The IP address of the reader is not known 
To select the relevant reader, proceed as follows: 

1. In the "Reader" menu, select the command "Set Reader IP Address". 

The "Communication Settings" dialog opens. 

2. Select the network to which the relevant reader is assigned in the "Network Address" box. 

3. Click the "Start Discovery" button. 

The application starts its automatic reader search and lists all the readers that can be 
accessed in the selected network. 

4. Select the desired reader from the list. 

5. Click the "Use Reader Address" button. 

Enter the IP address of the selected reader in the "IP address" input box. 

6. Click "OK". 

Result 
The reader affected by the transfer/back transfer was selected.  

The IP address of this reader is used for each subsequent transfer or back transfer. 
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4.2.6.2 Back transfer 
In a back transfer, the configuration is read out from a reader and imported into RF-
MANAGER Basic for further processing.  

Requirement 
The IP address of the reader affected by the back transfer is shown in the "Communication 
Settings" dialog in the "IP address" box (see "Requirements for transfer/back transfer 
(Page 75)"). 

Procedure 
To transfer the configuration from the reader to RF-MANAGER Basic, follow these steps:  

1. In the "Reader" menu, select the command "Import Configuration from Reader" or click 
the button . 

The "Import Configuration from Reader" dialog opens with the message "This operation 
will overwrite your existing project". 

2. Click the "OK" button. 

The back transfer is started and the configuration is transferred from the reader to the 
configuration computer. 

Result 
The output window displays whether the transfer was successful or whether an error has 
occurred. 

After successful transfer, the configuration is in RF-MANAGER Basic and can be edited 
further there. 

4.2.6.3 Export 
By selecting Transfer, you can copy the configuration data to the reader using 
RF-MANAGER Basic. 

To transfer the configuration data via the XML interface on the reader using an external user 
application, you need a configuration file generated by RF-MANAGER Basic.  

With the XML command "setConfiguration", you can then transfer this configuration file to the 
reader using an external user application.  

For further information, refer to the SIMATIC RF Function Manual. 
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Procedure 
To create the configuration file, follow these steps:  

1. In the "Reader" menu, select the command "Export Configuration" or click the button . 

The "Save as" Windows dialog is opened. 

2. Select a file name and storage location for the file. 

A consistency check is carried out. After a successful consistency check,  

the configuration file is generated and saved. 

  Note 
Consistency check has failed 

If the consistency check fails, the export is aborted and an error message is shown in the 
output window. 

  Note 
File name for export 

If you export a file, the project name is assigned as the default file name with the 
"_export.xml" file extension. 

Result 
The configuration file is generated and exported to the specified storage location. 

With the XML command "setConfiguration", you can transfer this configuration file to the 
reader via an external user application.  

4.2.6.4 Import 
With the import function, you can reimport a previously exported configuration file into RF-
MANAGER Basic as a project.  

Procedure 
To import the configuration file, proceed as follows:  

1. In the "Reader" menu, select the command "Import Configuration" or click the button . 

2. The "Open" dialog is opened in Windows. 

3. Select a configuration file in .xml format. 

4. Click "Next" to confirm that you really want to import the configuration file. During the 
import process, you can cancel the process anytime by clicking "Cancel". 

Result 
You receive a confirmation that the import process has been completed successfully. A new 
project with the data of your configuration file has been created.  
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Note that an empty new project is created in the event of a faulty import. 

4.2.6.5 Delete 
If significant problems occur when starting up the reader, it may be necessary in exceptional 
cases to delete the current reader configuration.  

Requirement 
The IP address of the reader involved in the transfer is shown in the "Communication 
Settings" dialog in the "IP address" box (see "Requirements for transfer/back transfer 
(Page 75)"). 

Procedure 
To delete the configuration data on the reader, proceed as follows:  

1. In the "Reader > Set Reader IP Address" menu, click the "Reset Configuration" button. 

Result 
The current configuration on the reader is deleted. You can now transfer a new configuration 
to the reader (see section "Transfer (Page 78)"). 

4.2.6.6 Transfer 
A transfer operation refers to the transfer of configuration data to the reader where the 
project is to run.  

Requirement 
The configuration has been completed and the IP address of the reader involved in the 
transfer is shown in the "Communication Settings" dialog in the "IP address" box (see 
"Requirements for transfer/back transfer (Page 75)"). 

Procedure 
To transfer configuration data from the configuration computer to the reader, proceed as 
follows:  

1. In the "Reader" menu, select the command "Transfer to Reader" or click the  button. 

A consistency check is carried out. After the consistency check is successful, the 
configuration data is transferred to the reader. 

  Note 
Consistency check has failed 

If the consistency check fails, the transfer is canceled and an error message is shown in 
the output window. 
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 Note 
Storing projects 

Save your projects locally. If you do not, you will not be able to transfer them to your readers. 

An error message will appear if you try to transfer a project from a non-local storage location 
to a reader. If this happens, restart the RF-MANAGER, reset the configuration and save the 
project locally. 

 

Result 
After successful transfer, the reader begins with the new configuration. 

4.2.7 Testing projects 

Introduction 
During configuration, the data entered is automatically tested for its plausibility.    

The plausibility test ensures, for example, that value ranges are maintained and incorrect 
input is indicated during the configuration phase.    

There is no check for faulty configurations during input. The assignment is checked with the 
"Check consistency" function and displayed as an error. 

Perform consistency check 
To locate configuration errors, start the consistency test by clicking the "Check consistency" 
icon or with "Reader > Check consistency". All faulty points in the project are listed in the 
Output View. Then skip to the cause of fault. Work through the fault list from top to bottom.    
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4.2.7.1 Troubleshooting 

Introduction 
After completing the consistency test in the project, the results of the test appear in the 
Output View. There are three different result categories    

● Notes 

It is possible that logical links in the project are not correct or not available. Check the 
logical links of the project in conjunction with the alarms. The generating operation is fully 
executed. 

● Warnings 

The project contains errors that may lead to a restricted operation of the reader. The 
generating operation is fully executed. 

● Error 

Errors must be eliminated so that your data can be fully transferred to your reader. The 
error number helps to identify the type of error. 

 
You can obtain help on the individual messages by moving the mouse pointer to the relevant 
message row and pressing <F1>. 

Procedure 
1. Click the "Check consistency" icon to run the consistency check for the project. 

The configuration data are now verified. Notifications, warnings and faults are shown in 
the Output View.  

2. Double-click an entry in the Output View to access the location in the project which 
caused the fault. 

3. Clear the fault. 

  Note 

Clear the faults in succession because follow-up faults could already have been cleared 
after clearing a fault. 
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4.2.7.2 Basic functional test of the reader using SIMATIC RF-MANAGER Basic 

Requirements    
If problems occur when using the RF600 reader, you can check the general functionality as 
follows: 

● The antenna configuration must be as shown in the figure below. 

● The reader is connected to the SIMATIC RF-MANAGER Basic. 

● RF-Manager 2008 and RF-Manager 2008 Runtime must not have been started. 

Procedure 
To check whether the reader can read a tag, proceed as follows: 

1. Open the RF-MANAGER Basic. 

2. Select the IP address of the reader to be checked (see "Requirements for transfer/back 
transfer (Page 75)"). 

3. Hold a tag on an electromagnetically neutral base in the middle in front of the antennas. 

NOTICE  
 

As a base use wood or plastic, for example, but definitely do not use any metallic or 
field-influencing materials. 

4. In the "View" menu, select the "Start diagnosis view" command or click the  icon. 

The "Diagnosis View" dialog box is opened. 

5. Click the "Start" button. 

 

 
Figure 4-3 Configuration to test the reader 
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Result 
If the tag in the field can be read by the reader, it will appear in the list in the "Diagnosis 
View" dialog. In addition, the orange LED of the reader indicates that a tag recognized by the 
reader is presently located in the field. 

4.2.7.3 Diagnosis view 

Diagnosis view - general 

Introduction 
The diagnosis view enables the reader to test the accuracy of tag detection in the following 
scenarios: 

● Commissioning of the reader and testing of the loaded configuration 

● Checking and testing the reader on commissioning in the plant 
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Diagnosis view 
The diagnosis view can be opened in RF-MANAGER Basic with the "View > Start diagnosis 
view" menu command.    

 
① Status bar 

Display of reader status 
② "Connect" button 

Connects the reader to the configuration computer if the connection was disconnected 
previously by clicking the "Disconnect" button. 

③ "Disconnect" button 
Disconnects the reader from the configuration computer, but the reader continues to operate. 

④ "Reboot" button 
Disconnects the reader from the configuration computer and the reader is reset.  
Each project is saved fail-proof on the reader so that after resetting, the reader starts with the 
project's original download state. 

⑤ Tabs of the "Diagnosis View" dialog 
Display of the diagnostic data 



Working with RF-MANAGER Basic  
4.2 Working with projects 

 RF-MANAGER Basic V3 
84 Operating Manual, 09/2012, A5E03125518-03 

⑥ "Information" window 
Chronological list of all settings made and display of additional information such as INFO 
message when there is an overflow of the maximum number of displayable rows in the display 
list and the oldest (top) rows are then discarded. 

⑦ "Clear View" button 
Deletes all entries in the "Information" window. 

Figure 4-4 Diagnosis view - general 

Diagnosis view - "Tag ID" tab 

Introduction 
With the diagnostics data of the "Tag ID" tab, a basic functional test (Page 81) of the reader 
can be run, along with a test to determine how well a tag can be detected in the field. 

Synchronous data scan 
To access the data displayed in the "Tag ID" tab, the data source or all data sources are 
queried synchronously for data. One read operation (Inventory) per query is performed on 
the reader for each data source. 

There is no asynchronous automatic data scan via the data source triggers created in the 
project. In this view, no tag IDs from data sources are shown that are available via Reports. 
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"Tag ID" tab 

 
① Drop-down list 

Select a specific data source or all data sources. 
② "Read duration" input box 

The default value is 0 ms so that the reader starts only one read procedure. 
③ "Tags read" display box 

The number of tags recognized by the reader per read procedure. 
④ "Count" option 

Activated: 
Displays the number of read operations in which the tag was detected. 
Only one row is displayed per recognized tag.  
Deactivated: 
Each detected tag event is listed chronologically. 
The "RSSI max", Cycles and "Count" columns are not displayed. 

⑤ Display list 
Displays the data of a tag. 

⑥ "Clear View" button 
Deletes all entries in the display list. 
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⑦ "Stop" button 
Cyclic reading is stopped. 

⑧ "Start" button 
Reading is triggered cyclically. 

⑨ "Single" button 
Reading is triggered once. 

Figure 4-5 Diagnosis view window - "Tag ID" tab 

Reading, read duration, and cycle 
The reading process is initiated at the beginning of a read duration. Within the read duration, 
the reader continuously collects the data (Tag IDs) of the detected tags. At the end of the 
read duration, the reading stops and the data collected (Tag IDs) is transmitted from the 
reader to the configuration computer. Per tag only one data record (Tag ID) is sent, even if 
the tag is detected several times in the read duration.  

This entire procedure corresponds to one cycle. 

Querying data sources 
Using the drop down list, a single data source or all data sources together can be selected 
for the data scan. The data scan can occur once ("Single" button) or cyclically ("Start" 
button). 

If all data sources are queried once or cyclically, then the read operation is initiated for each 
data source in succession. The read operation can begin for the next data sources only after 
if it has been completed for the previous data source. 

Presentation of data in the display list 
The data obtained by the reader from a tag during a read cycle is sent to the configuration 
computer and displayed in a row in the display list per tag.    

The following parameters are displayed for each tag: 

● Tag ID 

The Tag ID of the tag read by the reader. 

● Data source 

Display of data source from which the reader receives the data. 

● Antenna 

Specification of which antenna the reader used to detect the data. 

● RSSI min 

The lowest RSSI value of the tag determined so far. 

● RSSI max 

The highest RSSI value of the tag determined so far. 
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● Cycles 

Number of read operations in which at least one tag was detected by the reader. 

● Count 

Number of read operations in which the tag was detected. 

● Time 

Timestamp that states when the tag was last detected by the reader. 

 

If the "Counted" option is activated, the rows are color-coded: 

 
Color Meaning 
Dark green The tag was detected in the current read cycle. 
Light green The tag was detected in the previous read cycle, but not in the present read cycle. 
Red The tag has not been detected since at least the previous read cycle and in the 

current read cycle. 

 

To avoid overburdening the configuration computer's memory, a maximum of 10000 lines 
are displayed With more than 10000 lines, an overflow occurs and the oldest (= top) row is 
discarded. 

Diagnosis view - "Tag Events" tab 

Introduction 
The diagnostics data of the "Tag Events" tab can be used to test the reader to see if it 
detects tag status changes and displays the corresponding tag events, without requiring the 
corresponding hardware to be connected to the reader to fire a trigger (e.g. light barriers). 

The triggers can be fired manually instead with RF-MANAGER Basic by clicking the "Single" 
or "Start" buttons. 

This allows the configuration and commissioning of the reader to be tested in the system. 

Asynchronous data scan 
To receive the data displayed in the "Tag Events" tab, the reader automatically delivers the 
tag events asynchronously according to the configuration loaded on the reader. 

Further information on asynchronous automatic data queries can be found in the chapter 
"Understanding and optimizing the scanning of RFID tags". 
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"Tag Events" tab 

 
① Drop-down list 

Select data source 
② "Counted" option 

Activated: 
Displays how often a tag event has been detected. 
One row is displayed for each detected tag event per tag.  
Deactivated: 
Each detected tag event is listed chronologically. 
The "RSSI max" and "Count" columns are not displayed. 

③ Display list 
Displays the data of a tag. 

④ "Clear View" button 
Deletes all entries in the display list. 

⑤ "Stop" button 
The data source scan is canceled. 

⑥ "Start" button 
The data sources are triggered cyclically. 
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⑦ "Single" button 
The data sources are only triggered once. 

Figure 4-6 Diagnosis view - "Tag Events" tab 

Querying data sources 
Using the drop down list, a single data source or all data sources together can be selected 
for the data scan. The selected data sources are triggered once or cyclically with the settings 
given in the RF-MANAGER Basic configuration. 

The data source trigger is released only once if there is a single data source scan ("Single" 
button). 

The data source trigger is released continually if there is a cyclical data source scan ("Start" 
button). 

Presentation of data in the display list 
The data obtained by the reader from a tag during a read cycle is sent to the configuration 
computer and displayed in a row in the display list per tag/tag event combination.    

The following parameters are displayed for each tag: 

● Tag ID 

The Tag ID of the tag read by the reader. 

● Event 

The tag's current tag event detected by the reader ("Observed", "Lost", etc.), depending 
on the current configuration. 

● Data source 

Display of data source from which the reader receives the data. 

● Antenna 

Specification of which antenna the reader used to detect the data. 

● RSSI min 

The lowest RSSI value of the tag determined so far. 

● RSSI max 

The highest RSSI value of the tag determined so far. 

● Count 

Displays how often the tag event is detected for the tag. 

● Time 

Timestamp that states when the tag event was last detected by the reader for the tag. 

To avoid overburdening the configuration computer's memory, a maximum of 10000 lines 
are displayed With more than 10000 lines, an overflow occurs and the oldest (= top) row is 
discarded. 
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Diagnosis view - "IO" tab 

Introduction 
By configuring the inputs/outputs, the reader's hardwired inputs and outputs can be function 
tested with the diagnostic data of the "IO" tab and, for example, wiring errors or physically 
defective inputs or outputs can be detected. 

 

 Note 
Activation of the "Notification" option of "IO" in the project is required  

To configure the relevant input/output in RF-MANAGER Basic, in the "IO" tab, either set the 
value to "True" in the "Notifications" column or activate the option "Send notifications" in the 
"General" properties window. 

The status change is displayed only for these inputs/outputs in the display list in the 
"Diagnosis view" dialog under the "IO" tab. 

 

"IO" tab 
 

 Note 
"HIGH"/"LOW" 

The following assignment applies to the terms "HIGH" and "LOW": 
• "HIGH" = "ON" 
• "LOW" = "OFF" 
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① "Count" option  

Activated: 
Displays how often a status change has occurred. 
A maximum two rows are displayed per input/output for the two possible values "HIGH" and "LOW". 
The relevant row is updated on a status change at the input/output, e.g. if the input/output is set to "HIGH" 
following a status change of the input/output, the previous "HIGH" row of the input/output is updated. 
Deactivated: 
Each status change of the input/output is listed chronologically. 
The "Count" column is not shown. 

② Display fields "Inport 00" to "Inport 03" 
Displays the value of each input set by hardware using a colored background: 
Yellow = "ON" 
Gray = "OFF" 

③ Display fields "Outport 00" to "Outport 03" 
Display the value of each output set by hardware using a colored background: 
Green = "ON" 
Gray = "OFF" 

④ Drop-down list per output "Outport 00" to "Outport 03" 
Manual setting of the value for the associated output. 
The value in the display field for the relevant output is accepted by clicking on "Set Outports". 



Working with RF-MANAGER Basic  
4.2 Working with projects 

 RF-MANAGER Basic V3 
92 Operating Manual, 09/2012, A5E03125518-03 

⑤ "Set Outports" button 
The values set manually in the drop-down lists are accepted in the display fields "Outport 00" to "Outport 03". 

Figure 4-7 Diagnosis view - "IO" tab 

Presentation of data in the display list 
One completed status change per input/output is displayed in a row in the display list.    

The following parameters are displayed for each IO: 

● Name 

Name of IO port. 

● Event 

Display of value at input/output following a completed status change: 

– "HIGH" following a status change from "LOW" to "HIGH" (rising edge) 

– "LOW" following a status change from "HIGH" to "LOW" (falling edge) 

● Count 

Registers a status change at the input/output. 

● Time 

Time stamp that states when the status change at the input/output last occurred. 

To avoid overburdening the configuration computer's memory, a maximum of 10000 lines 
are displayed With more than 10000 lines, an overflow occurs and the oldest (= top) row is 
discarded. 

Diagnosis view - "Alarms" tab 

Introduction 
The "Alarms" tab displays device-specific system and error alarms from the reader. 

You will find more detailed information on device-specific system alarms and error messages 
in the SIMATIC RF Function Manual (see the CD / DVD-ROM supplied with the 
RF640R/RF670R reader). 
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"Alarms" tab 

 
① "Clear view" button 

Deletes all entries in the "Alarms" window. 

Figure 4-8 Diagnosis view - "Alarms" tab 

To avoid overburdening the configuration computer's memory, a maximum of 10000 lines 
are displayed With more than 10000 lines, an overflow occurs and the oldest (= top) row is 
discarded. 

4.2.8 Firmware update 
The firmware update allows a specific firmware version to be transferred to the reader.  

Requirement 
The IP address of the reader involved in the firmware update is shown in the 
"Communication Settings" dialog in the "IP address" box (see "Requirements for 
transfer/back transfer (Page 75)"). 
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Procedure 
To update the firmware, proceed as follows:  

1. In the "Reader" menu, select the command "Update firmware". 

The "Open" Windows dialog opens. 

2. Select the desired file for the firmware update and then click "Open". 

The file is transferred to the reader and written to its internal memory, and then the reader 
is restarted. This can take several minutes. The data transfer is indicated by the LED 
flashing. 

  Note 
LED display with "old" firmware versions 

When you update "old" firmware versions, it is possible that the LED of the reader does 
not flash during the firmware update. 

Result 
After the firmware is updated, the reader's LED flashes green. 
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4.3 Reader parameter assignment 

4.3.1 Introduction 
In the workplace you can parameterize the readers of your RFID system. You can set 
general parameters for the antennas that are connected to the reader.  

 
And you can create data sources for the purpose of reading tags and notification channels 
for transferring the scanned tags. It is also necessary to specify triggers: Triggers that 
activate the data sources for reading and triggers that activate the notification channels to 
transfer the data of the data sources that are assigned to you. 

The RFID devices are parameterized in the following stages: 

● RFID device 

● Antennas 

● Data sources 

● I/O Ports 

● Notification channels 

● Trigger 

● Tag selectors 

● Data selectors 
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4.3.2 RFID device 
The "RFID device" menu provides the following parameter setting options: 

General 

 
Here you can enter the IP address set for the reader and the radio profile used for the 
reader.      
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Properties 
● Radio settings 

 
You can set the radio profile used for the reader under "Radio settings"  

If your RFID system is using "Frequency hopping", here you can select the transmit 
channels between which the reader hops. 

Frequency hopping is used to prevent mutual inference from the readers. If frequency 
hopping is not activated, you must permanently assign the transmission channel by 
means of an ID. If the FCC radio profile is used, however, frequency hopping cannot be 
deactivated.    

  

You can set the following parameters under "Air Protocol":  

"Retries before failure: 

Here you can set the maximum number of repetitions of a faulty air protocol command. 
The command is terminated and an error reported only when the command has failed in 
all attempts. With this setting you can reduce the likelihood of errors when accessing 
tags. However, this lower error probability leads to an increased time required for 
command execution. The maximum execution time may increase depending on the 
actual number of repetitions performed. For time-critical applications, it may therefore be 
advantageous to turn off the repeat and if needed, to respond in the application and then 
selectively make the repetition. 

 "Write Boost" 

Here you set how many decibels the antenna performance is increased for writing of data 
or the ID to the tag. To write data or an ID, a tag that can be read needs about 3 dB more 
energy at a constant distance. This increased capacity reduces interference potential and 
increases performance. An increase can only be up to the maximum allowed power. 

 "Sensitivity" 

Here you set the attenuation of the tag responses in the input branch of the reader. An 
increase in attenuation causes weak received tag signals to no longer be recognized by 
the reader. A decrease means that even weak received tag signals are detected. On the 
other hand, decreased attenuation brings with it the disadvantage that interference can 
negatively affect detection. The attenuation simultaneously affects all antennas. 
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● Tag protocol 

 
This is where you select the communication protocol to be used between the reader and 
tag.    

With EPC Class1 Gen2, you can use "Initial Q" to specify the maximum number of tags 
that can be expected to be located in the measuring field at the same time so that 
collisions can be prevented.  
The following formula applies: 2 Initial Q value = number of expected tags.  
It is important to note here that the length of a read cycle increases with the value of the 
Initial Q value. Normally this value is automatically set by the reader. If, however, you 
want to optimize performance, the rule of thumb is that the value must be set as low as 
possible and as high as necessary.    

Under "Tag communication scheme", you can set the data transfer rates between reader 
and tag for EPC Gen2 (see "Tag modulation schemes (Page 104)").    

See also: 

Help system Understanding and optimizing the scanning of RFID tags 

Under "Tag ID Length", you can select the setting "Automatic" or "Specific". "Automatic" 
means that tags of different lengths are detected. Select the setting "Specific" only when 
you are sure that there will only be tags with the same length or only specific ID lengths 
are desired. Tags with different ID lengths are ignored. 
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● Connection 

 
By activating the option "Transacted transfer" it is ensured that all events and alarms 
reach the user application. In the event of network problems, events and alarms are 
buffered by the reader and are not lost. Note that if the function "Transacted transfer" is 
enabled, events and alarms must be acknowledged via XML message frames. If you do 
not acknowledge events and alarms in the user application, the connection to the reader 
is considered to be faulty and the reader sends the same events and alarms over and 
over again. 

If "RSSI events" is activated, then for each tag a message containing the information 
"Tag ID", "RSSI value" and "active antenna" is generated for all read processes and tag 
commands that result in the acquisition of the tag ID at the air interface. This information 
can be useful during commissioning.  

NOTICE  
 

Very many messages 

Very many messages are generated for large tag populations, which can reduce overall 
performance and lead to overload. Disable "RSSI events" after commissioning if you 
work with large tag populations. 

With the "Delta threshold" parameter you can set the difference in the RSSI value per tag 
from which a new RSSI message is created. If, for example, the value is set to "10" and a 
message has been generated at an RSSI value of 50 for the tag with ID x, a new 
message is created when a value of >60 or <40 is reached. No messages are generated 
at RSSI values in between to avoid a flood of messages on small changes.  

If "Command response events" is activated, messages containing information such as 
command, ID, result of the command, RSSI value, active antenna, etc. are created for all 
tag command (e.g. WriteID, Kill, Lock, etc.) and for each tag. If the command was 
executed on several tags, separate messages are generated for each individual tag. At 
the end of a command execution, an additional message is created with a summary of 
the results (tags OK, number of tags NOK). 

During commissioning, you can enable this option in order to detect problems with 
command execution. After the commissioning you should disable the option again, 
otherwise a lot of data will be generated, causing the overall performance of the system 
to be reduced or leading to an overload.  
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● System 

 
Under "Asynchronous reader mode", you can change the operating mode of the RFID 
module. In asynchronous reader mode, the RFID module continuously reads tags that 
are present in the field. Even if always the same tag is in the field, the same tag is 
constantly read and the data source made available. If the option is not enabled, the 
RFID module will only read in response to an explicit request from the data source or in 
accordance with the configured trigger conditions. 

You use "Asynchronous reader mode" when you want tags to be detected as quickly as 
possible. In this mode, the software does not provide a trigger because the reader reads 
autonomously. You will need this function for high-speed processes in which temporary 
reading pauses are not acceptable. 

  Note 
Preconditions/settings 
• Read settings: Set the threshold for "Observed" to 0. 
• Set all the participating components, e.g. data sources and notification channels, to 

continuous triggering. 

  Note 
Only one data source 

Please note that you can only parameterize one data source for your reader in 
asynchronous reader mode. Scenarios with multiple data sources are not permitted! 

In the "System" dialog, you can set the reader's start behavior. All checkboxes are 
activated by default. If the option "Start reading" is deactivated, the reader is in stop mode 
and does not read any data when it starts. If the options "Start sending alarms" and "Start 
sending notifications" are deactivated, neither alarms nor notifications (reports) are 
transmitted when the reader starts. It can make sense to deactivate this function if the 
reader is addressed via an XML interface and a specific startup procedure is to be 
ensured. Send explicit XML read commands to start a read operation on the reader from 
this state.  
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● Properties 

 
The dialog "Properties" contains expert parameters for special applications. These expert 
parameters permit the subsequent optimization for difficult applications.  

The following expert parameters can be set in the "Properties" dialog: 

 
Parameter Description Default setting 
RFInterfaceModulationType The readers provide two basic modulation types: 

• Double Sideband (DSB) 
• Phase Reversal Amplitude Shift Keying (PR-ASK) 

modulation. 
 

PR-ASK modulation is the 
default setting and should not 
be changed. 

TagCommUsePilotton To ensure that the RFID module can better synchronize 
with the transponder response, the tag is told to transmit a 
pilot signal (x ms long) via the air interface. If no fault is 
expected in the field, the pilot signal can be switched off 
(minimal time savings). But the user is advised to always 
leave the pilot signal switched on. 

ON = 255 

TagCommIntelligentWrite In comparison with the reading process, the writing 
process is a very slow process. The concept of intelligent 
writing includes reading of the special cells to be written in 
the tag, comparing of words (2 bytes), and word-by-word 
writing of only those words that deviate in content between 
target data and actual data. 
Users who would like to write the contents of the memory 
in any case, due to the medium-length data management 
period, will shut down this mechanism. 

ON = 255 

TagCommVerifyWrite When writing data to transponders, the transponder can 
acknowledge correct writing in the event of a defective 
memory cell, but during the next reading, it is discovered 
that memory cells were not correctly written compared to 
the acknowledgement. 
In order to be able to prevent such data corruption, the 
corresponding memory cells are read word-by-word by the 
reader after writing data on tags and then compared to the 
writing data by default. 
Users who do not want to use this mode can disable the 
mechanism via the expert parameter defined here. 

ON = 255 

TagCommForcePowerOffAfter
EPCWrite 

In order to be able to optimize the inventory 
chronologically, you must ensure that a tag briefly exits the 
status after overwriting the EPC ID in order to be assigned 
a new status in a different inventory as soon as possible. 
This timed response can be achieved by switching off the 
power for X ms after the EPC ID is written. 

The setting range for the wait 
time is 0 ms to 255 ms. The 
default is a pause of 5 ms. 
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Parameter Description Default setting 
RFInterfaceTimeToPowerOff This time specifies how long the carrier remains switched 

on after a tag operation, taking the restrictions of the 
selected communication standard into consideration. 
The advantage of selecting a sufficiently long carrier 
running-on time is that after data accesses, the reader 
leaves the carrier of a channel switched on, thus saving 
time when the data accesses are used again. 

5 s 

RFInterfaceMultiplexing 
ExposureTime1 ... 4 

These settings only become effective when the reader is 
operating in asynchronous mode (see 
RFID device > Properties > System). 
In this mode, the RFID module continuously executes read 
cycles (inventories) and switches the antennas according 
to the set times. Time 1 ...4 corresponds to Antenna 1 ... 4 

100 

GlimpsedTimeoutCount 
ObservedTresholdCount 
ObservedTimeOutCount 

Three counters are reserved in the tag list for each tag. 
They can be changed by the user. 
These settings only become effective when the reader is 
operating in asynchronous mode (see RFID 
device > Properties > System). In this mode, the RFID 
module continuously executes read cycles (inventories). 
When a tag is reported depends on the number of 
identifications and the resulting states.  
The tag status "Observed" is reported.  
Possible states:  
• Glimpsed 
• Observed 
• Lost 
The basic model of smoothing is described in the chapter 
"Understanding and optimizing the scanning of RFID 
tags". 

GlimpsedTimeOutCount = 1 
ObservedTresholdCount = 0
ObservedTimeoutCount = 5 

TagCommTransmitSelectIf 
NoFilterIsOn 

Before each read cycle, the reader sends a select 
command at the air interface to switch tags into a defined 
idle state. This procedure is only required if tags changed 
their states due to previous filter functions. 
If it is ensured that no filters affect tags via the air 
interface, the read performance can be increased by 
omitting the select command. 

ON = 255 

TagCommUseBlockWrite The EPC Gen 2 air protocol supports the command 
"BlockWrite" for simultaneously writing several words to 
the tag. If only tags that support this command are used, 
you can activate this write mode exclusively. Word-by-
word writing is then deactivated. 

OFF = 0 
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● Data selector 

 
You can select the current data selector or define new data selectors here. Please note 
that the data selector chosen here will only be effective in the following cases: 

– During synchronous read procedures 

– Or for notification channels for which a data selector has not been explicitly selected. 

In general, data selectors are components of notification channels and are used with the 
asynchronous read procedure.      

For further information on using data selectors, see "Dense Interrogator mode 
(Page 104)". 

● Information 

 
You can store descriptions regarding the reader, reader location, responsible contact 
person(s) and reader role here.        

● Events 

 
"On Alarm" 

If the reader triggers an alarm, this event is triggered. You can configure function lists for 
the event in order to execute system functions. 

You can find further information on the use of lists of functions in the chapter "Working 
with system functions". 
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4.3.2.1 Tag modulation schemes 
You set the data transfer rate between reader and tag using tag modulation schemes. This 
parameterization is only possible with the tag protocol EPC Class1 GEN2.  

EPC Class1 GEN2 tag communication schemes 
 
Index Reader - 

Tag Tari* 
Reader - Tag 
data rate 

Link 
frequency 

Tag - reader 
data rate 

Coding ETSI-
compatible 

FCC-
compatible 

0 25 μs 40 kbps 80 kHz 80 kbps FM 0 Yes Yes 
2 25 μs 40 kbps 160 kHz 160 kbps FM 0 Yes Yes 
4 25 μs 40 kbps 160 kHz 40 kbps Miller 4 Yes Yes 
5 12.5 μs 80 kbps 160 kHz 160 kbps FM 0 Yes Yes 
7 12.5 μs 80 kbps 160 kHz 40 kbps Miller 4 Yes Yes 
9 12.5 μs 80 kbps 320 kHz 160 kbps Miller 2 Yes Yes 
10 12.5 μs 80 kbps 320 kHz 80 kbps Miller 4 Yes Yes 
11 12.5 μs 80 kbps 320 kHz 40 kbps Miller 8 Yes Yes 
12 6.25 μs 160 kbps 320 kHz 320 kbps FM 0 No Yes 
13 6.25 μs 160 kbps 320 kHz 160 kbps Miller 2 No Yes 
14 6.25 μs 160 kbps 320 kHz 80 kbps Miller 4 No Yes 
15 6.25 μs 160 kbps 320 kHz 40 kbps Miller 8 No Yes 

* Tari = Duration for representation of a bit with content 0. 

4.3.2.2 Dense Interrogator mode 

Core statement 
The dense interrogator mode for Gen 2 tags (schemes with Miller coding) enables several 
RF600 readers to be operated without interference in close proximity to each other.  

Operating principle 
When using Gen 2 tags, a so-called Miller subcarrier permits readers located close to one 
another to use the same frequency. This is achieved by inserting a frequency offset for the 
signal carrier in the tag (by using a square-wave hybrid signal). 
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As a result of the large difference in level between the transmitter channels and the tag 
response channels, this technology provides great advantages for frequency reuse. 
However, a prerequisite is that a certain minimum distance, and thus minimum decoupling, is 
observed between the antennas of adjacent readers. 

 

 Note 
Minimum distance between antennas 

The minimum distance required between antennas using the same frequency depends on 
the radiated power set and the antenna alignment.  

 

You will find information on antenna alignment and antenna clearances in the "SIMATIC 
RF600 (http://support.automation.siemens.com/WW/view/en/22437600)" system manual. 

Optimizing tag reading accuracy 
A further improvement in the tag reading accuracy in an environment with a high density of 
readers can be achieved by orienting the antennas toward the respective tag field, i.e. by 
rotating them horizontally and vertically. 

The radiated power of the readers can also be reduced to the absolute minimum level at 
which the tags can still be detected accurately.  

This greatly reduces the probability of interference.  

4.3.3 Antennas 

4.3.3.1 Antennas 
The "Antennas" menu provides the following parameter assignment options: 

General 

 
In this window, you can specify the radio properties of an antenna. The "Name" of the 
antenna and the antenna port allocated to it are assigned automatically.  

The maximum "Power" is limited by the radio profile and communication scheme used. The 
settings for the "antenna gain" and "cable loss" parameters are dependent on the hardware 
used. 

With the Enable check box, you can enable the antenna. 

http://support.automation.siemens.com/WW/view/en/22437600�
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The operating mode of the antenna with RF670R is preset to TX/RX, as the reader operates 
the antenna monostatically, i.e. transmitting and receiving take place simultaneously. 

You will find more detailed information on the radiated power of the antennas in the RF600 
system manual (http://support.automation.siemens.com/WW/view/en/22437600). 

RSSI threshold value 
RSSI RSSI (Received Signal Strength Indication) data provides information about the 
received field strength with which a tag is read. To reduce the effect of overshooting when 
accessing transponder data, setting a threshold allows weak received transponder signals 
that do not reach the Received Signal Strenght Indicator (RSSI) threshold to be discarded by 
the reader. An analysis of RSSI data may also help, for example, to initiate a write operation 
only if there is a sufficiently strong tag in the field. This can increase the writing success rate. 

The value is a unitless amount without direct conversion to the level and a value range of 0-
255 (default 0). 

Properties 
Information 

 
You can store a description of the antenna here. 

See also 
SIMATIC RF600 (http://support.automation.siemens.com/WW/view/en/22437600) 

http://support.automation.siemens.com/WW/view/en/22437600�
http://support.automation.siemens.com/WW/view/en/22437600�
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4.3.3.2 Radiated power of antennas 
The maximum radiated power of the antennas is restricted by the radio profile used. 
Parameterization of antenna gain and cable loss depends on the hardware used.  

ETSI radio profile 
With the ETSI radio profile, the minimum radiated power is 50 mW ERP and the maximum 
2000 mW ERP. The set power corresponds to the desired effective radiate power (ERP), 
and is calculated for the reader based on the entered parameters "Antenna gain" and "Cable 
loss".  

Example:  
The RF660A ETSI antenna has a gain of 7 dBi, and a 10 m LMR-195 cable has a loss of 
4 dB; an LMR-300 cable has a loss of 2 dB.  

You will find more detailed information on antenna gain in the relevant frequency band, and 
on the cable loss of the antenna cables currently available, in the RF600 system manual 
(http://support.automation.siemens.com/WW/view/en/22437600). 

FCC radio profile 
With the FCC radio profile, the minimum radiated power is 100 mW EIRP and the maximum 
4000 mW ERP. The set power corresponds to the desired signal level on the end of the 
antenna cable and is calculated for the reader based on the entered parameters "Antenna 
gain" and "Cable loss".  

Example: 
The RF660A US antenna has a gain of 6 dBi, and a 10 m LMR-195 cable has a loss of 4 dB; 
an LMR-300 cable has a loss of 2 dB.  

You will find more detailed information on antenna gain in the relevant frequency band, and 
on the cable loss of the antenna cables currently available, in the RF600 system manual 
(http://support.automation.siemens.com/WW/view/en/22437600). 

CMIIT radio profile 
With the CMIIT radio profile, the minimum radiated power is 50 mW ERP and the maximum 
2000 mW ERP. The set power corresponds to the required 
effective radiated power (ERP), and is calculated for the reader 
 based on the specified "Antenna gain" and "Cable loss" parameters 
.  

Example: 
The RF660A FCC antenna has a gain of 6 dBi, and a 10 m 
LMR-195 cable with a loss of 4 dB / an LMR-300 cable with a loss 
of 2 dB. 

You will find more detailed information on antenna gain in the relevant frequency band, and 
on the cable loss of the antenna cables available, in the RF600 system manual 
(http://support.automation.siemens.com/WW/view/en/22437600). 

http://support.automation.siemens.com/WW/view/en/22437600�
http://support.automation.siemens.com/WW/view/en/22437600�
http://support.automation.siemens.com/WW/view/en/22437600�
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4.3.4 Data sources 
Data sources read the data from logically associated antennas. The data sources pass on 
the data that are read from the antennas assigned to them.  

The "Data sources" menu provides the following parameter setting options: 

General 

 
You can assign a name to the data source using the "Name" parameter. Under "Antennas", 
you can assign the available antennas to the data source.      

If you selected EPC Class1 Gen2 as the communication protocol between the reader and 
the tags, you must specify the session parameters for the data source. One tag can 
communicate with up to 4 data sources simultaneously, so to distinguish between these data 
sources, a unique number S0 to S3 is assigned to each via the session parameters.    

With "Activate", you can activate the data source.    
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Properties 
● Data acquisition 

 
With "Radio settings" you can choose between "Repeated reading" and "Bulk reading".  

If the "Repeated reading" option is enabled, you define the number of "Read cycles per 
trigger". The "Read timeout" specifies in milliseconds how long the specified number of 
read cycle per trigger is permitted to take. When this time limit is exceeded, the read 
cycles are stopped even if the number of cycles that you specified has not been reached.      

If the option "Bulk reading" is active, the reader continuously reads all tags in the fields in 
one read cycle. The "Read timeout" determines how long this continuous reading will last. 
Other data sources must wait during this defined read duration and are only processed 
when it ends. 

For more detailed information and general background information, please refer to: 

Help system "Getting started > Understanding and optimizing the scanning of RFID tags" 

● Smoothing 

 
Smoothing is a technique that is used to optimize the read quality. The reader adds a 
status indication for the tags to the read results.  

In this window, you specify the parameters for the status indication for the tags. Here you 
can specify times that have an effect on the status transitions.  
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The different statuses are described below:            

 
Status Meaning Description 

The tag has this status before communication is established with the reader. Unknown Unknown 
Data selector event "Purged": 
Status "Unknown" is achieved due to "Lost timeout". 
This status is assigned to the tag when it is read for the first time. Two times are 
activated: 
"Glimpsed timeout": 
If communication is established briefly and unintentionally, when the time Glimpsed 
timeout has elapsed, the status changes back to "Unknown". The tag is removed 
from the tag list. This is used to remove tags that have been briefly detected in the 
boundary areas of the reader. 
The rule of thumb is that "Glimpsed timeout" should be at least twice as long as a 
complete read cycle.  
"Observed threshold" 
If a stable connection exists beyond the time "Threshold for Observed, the status 
"Observed" is assigned to the tag. 
The rule of thumb is that Observed threshold should be at least twice as long as one 
complete read cycle. 

Glimpsed Briefly detected 

Data selector event "New":  
The status "Glimpsed" was achieved from status "Unknown" for the first time. 

Observed Reliably detected An interruption in the communication that is shorter than the set time "Observed 
timeout" has no effect on the current status. This time interval can be used to 
suppress temporary interference. 
The rule of thumb is that Observed timeout must be twice as long as one complete 
read cycle. 
When the times of the read triggers are set longer than the "Observed timeouts", 
there is a danger that tags that remain stationary in the field will be lost.  

Lost  Lost When a tag exits the field of the reader, the status "Lost" will be assigned to it after 
the time "Observed timeout" has elapsed. If communication is established again, the 
status "Glimpsed" will be assigned again immediately. The "Unknown" status is 
activated if communication is not established before the time "Lost timeout" elapses. 
The rule of thumb is that "Lost timeout" must be at least twice as long as one 
complete read cycle. 

For more detailed information and general background information, please refer to: 

Help system "Understanding and optimizing the scanning of RFID tags" 
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● Trigger  

 
You specify the read triggers here. They cause the data source to read the data from the 
tags that are located in the antenna field. You can select the triggers from the drop-down 
list or define them yourself.    

● Tag selectors 

 
You assign tag selectors to the data source here. You can select the selectors from the 
drop-down list or define them yourself. The data to be read and filtered is specified here. 
If a selector is not entered here, the tag IDs will be supplied from all tags.  
If several tag selectors with filter function are selected here, they will be combined with a 
logical and. If this is not desirable, you must create additional data sources.    

Events 

 
The following events to trigger system functions are available: 
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● Tag Detected 

As soon as a tag is detected by the data source, triggering is initiated. Only the system 
functions "SetIOPort" or "SetIOPortOnCondition" can be set as a trigger.  

By defining a tag selector for the system function "SetIOPortOnCondition", you can 
specify the tag data for which the output will be set.  

If several tags are recognized, triggering occurs for each tag. 

● Read Requested 

The triggering occurs at the start of each read request to the RFID module. Only the 
system function "SetIOPort" can be fired at the trigger. 

● Read Finished 

The triggering occurs at the end of a read request to the RFID module. Only the system 
function "SetIOPort" can be fired at the trigger. 

4.3.5 I/O Ports 
The digital I/Os of the RF600 readers can be activated or deactivated individually. Via the 
digital inputs, for example, read operations can be triggered by means of light barriers. 
Pertinent visual or acoustic feedback can be output via the digital outputs. 

The "I/O Ports" menu provides the following parameter setting options: 

General 

 
You can select an output from the table in the workplace. Its parameters can then be set via 
the Property view: 

In the input field "Inactivity Level", you can define the state of the output (High or Low) after 
switching on the reader. 

A time in ms can be entered in the "Automatic Reset Time" input field. After the reset time, a 
set output returns to the status defined via "Inactivity Level". If there is a further change in 
state during the Automatic Reset Time , the Automatic Reset Time starts from the beginning. 

The "Toggle Interval" indicates a time interval in ms. As long as a set output is activated, it 
automatically switches the status of the reader output at the beginning and end of this time 
interval.  

The parameters "Automatic Reset Time" and "Toggle Interval" can be combined with each 
other, so that the output automatically changes its state and after the given Automatic Reset 
Time returns to the level set under "Inactivity Level". 
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If you additionally activate the option "Send notifications", the reader will automatically 
generate an alarm after every status change. 

RF640R 

Note that the RF640R reader has 2 digital inputs and 2 digital outputs that can be assigned 
parameters. 

RF670R 

Note that the RF670R reader has 4 digital inputs and 4 digital outputs that can be assigned 
parameters. 

Events 

 
● Level High 

As soon as an input or output is switched on, the function list configured here is triggered. 
Only the function "SetIOPort" can be used in the list of functions. 

● Level Low 

As soon as an input or output is switched on, the function list configured here is triggered. 
Only the function "SetIOPort" can be used in the list of functions. 

4.3.6 Notification channels 
In accordance with the configured triggering mechanism and the data selector, the 
notification channels pass on the RFID data of the data sources assigned to them to the user 
application via the XML interface.  

The "Notification channels" menu provides the following parameter setting options: 

General 
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You can assign a name to the notification channel and assign a "Data selector" and one or 
more "Data sources" to it. You can define the data selector and the data source(s) yourself 
or select them from a drop-down list.        

If a data selector is not defined for the notification channel, the data selector will 
automatically be used that was defined as current in the "Data selectors" submenu on the 
RFID device.  

With "Activate", you activate the notification channel. 

For more information, refer to the sections " Parameterizing data selectors (Page 117) " and 
" Data sources (Page 108) ". 

Properties 
● Trigger 

 
You can specify here whether the events received from the data sources should be 
transmitted continuously or whether they should be passed on dependent on the 
notification channel trigger. You can select these triggers from the drop-down list or 
create them.   When you define the triggers, you can also specify when they will be 
activated. 

You will find more detailed information in the section "Triggers (Page 115)". 

Events 

 
● Data Sent 

As soon as the data supplied by the data sources is passed on to the XML interface to be 
sent to the application, the trigger is released. Only the system function "SetIOPort" can 
be set as a trigger. 
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4.3.7 Triggers 
Triggers represent activation mechanisms that can be used to control read and notification 
procedures. Tag data are read at specific times or the stored tag data can be transferred 
dependent on triggers. Triggers can be used with data sources (read triggers) and 
notification channels (notification channel triggers).  

The "Trigger" menu provides the following parameter setting options: 

General 

 
You can specify the trigger "Type" here and set the following parameters:      

 
Trigger Description Parameter settings 
Continuous The activity is triggered as soon as possible and 

operates continuously. 
For notification channel triggers, this means that 
notifications are transmitted immediately via the 
XML interface to the user application when a new 
event occurs. 

- 

I/O edge The activity is triggered by an external binary 
signal that specifies a transition: 0 → 1 or 1 → 0 
(rising or falling). 

The transition for the trigger ("rising" or "falling") 
must be specified.  
A digital I/O of the reader must be assigned to 
the trigger.  

I/O signal level The activity will be activated by an external binary 
signal as long as the level is Low or High. 

The trigger must be set to "Low" or "High". 
 The trigger must be assigned to a digital I/O of 
the reader. 

Application request The activity is triggered on request from the 
application via the XML interface. 

- 

Timer The activity is triggered in accordance with 
specified time intervals.  

The time ("Timer") between the triggers must 
be specified in milliseconds. 

Events 
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● Trigger fired 

As soon as a trigger is fired according to its conditions, the function list configured here is 
triggered. Only the function "SetIOPort" can be used in the list of functions. 

4.3.8 Tag selectors 
In the "Tag selector" tab, you can define mechanisms that use HEX character strings to 
control the detection of tags by the reader. Tag selectors are based on the EPC data and on 
the freely parameterizable user data. Tag selectors are components of data sources. 

In combination with tag fields, tag selectors determine which data are read. When the read 
data are filtered, tag selectors determine which tags are passed on and which are rejected. 

You can use the tag fields to filter on the basis of the values of the EPC components. For 
this purpose, you must select one of the predefined and unchangeable tag fields.  

If you want to filter on the basis of freely definable user data, new tag fields must be created 
for this purpose. 

Procedure 
Select the "Tag selector" tab. You can create a new selector here by double-clicking an 
empty line of the table with the left mouse button. You can edit it in the property view. 

General 

 
You can assign a name to the selector in "General".    

If you want to filter on the basis of EPC components, select a "Predefined tag field" 
("AccessPassword", "KillPassword" or "TagID").    

If you want to filter on the basis of freely definable user data, select the "User-defined tag 
field" option. Specify a name under "Tag field name". You can assign an address to the 
memory bank in "Memory bank". The "Offset" parameter supplies the start address within the 
memory bank in bits. Finally, enter the length of the tag field in bits in the Length parameter.    

Regardless of the type of filtering, the following applies: Enter a HEX character string in 
"Mask" that specifies the bit positions relevant for filtering in terms of the tag fields used. 
"Value" defines a HEX character string that specifies the bit values for the bit positions.    
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Example  

 
Contents of the freely parameterizable tag 
field 

1 2 3 4 5 6 

Mask 0 F F F 0 0 

Value 0 2 3 4 0 0 

If the "Inclusive filter" option is activated, all the tags are returned that correspond to the filter 
criteria - which was the case in the above example. 

If the inclusive option is not activated ("Exclusive filter"), all the tags are returned that do not 
correspond to the filtering criteria. If several tag selectors are created and they are assigned 
to a data source, a tag will only be supplied if it matches at least one inclusive filter and does 
not match any exclusive filter.  

If you only want to read the RFID data, activate the option "No filter" - then filtering will not be 
performed. 

If, for example, from a large number of tags, only the tags of two manufacturers should be 
supplied, you will need two tag selectors. For each of these, specify a field in Tag field name 
that contains the manufacturer's name and enable the "Inclusive filter" option. In Mask / 
Value, one of the manufacturers must be set for each tag selector. 

If you want to work with several tag selectors, but the parameterization does not permit it, 
you must configure several data sources with the same antennas. 

4.3.9 Parameterizing data selectors 
In the "Data selector" tab, you can define selectors that will further reduce the volume of 
information and determine which information should be passed on. Data selectors are 
components of notification channels and can only be used with the asynchronous read 
procedure. 

Procedure 
Select the "Data selector" tab. You can create a new data selector here by double-clicking 
an empty line of the table with the left mouse button here. You can edit it in the property 
view. 
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General 

 
You can assign a name to the data selector and link it to the tags with "Event filters" in terms 
of the status description - depending on with the parameter settings made in "Smoothing". 
The set event types are transferred to the user application. You can select up to six 
predefined event filters (meaning, see section "Who do I let know? (Page 50)"). 

You can also assign reader fields to the data selector. These determine which information 
(e.g. reader name or tag type) within the report will be provided to the user application.            

 
Available reader fields 
Name Meaning 
Event trigger Read trigger that led to creation of the event 
Event type Event type / Status description of the tags 
Event time (ticks) Time of event in ticks 
Event time (UTC) Time of event in UTC format 
Reader EPC EPC of the reader specified by the manufacturer 
Reader handle Number for identification of the reader  
Reader name Name of the reader 
Reader role Role of the reader 
Reader time (ticks) Time of event handover in ticks 
Reader time (UTC) Time of event handover in UTC format 
RSSI value Signal strength of the tag 
Tag type Tag type used 
Tag ID ID of the tag 
Data source name Name of the data source 
Notification channel name Name of the notification channel 
Notification channel trigger Name of the notification channel trigger 
Transmitting antenna Name of the antenna that was transmitting when the tag 

was detected. 
All event fields - 
All reader fields - 
All notification fields - 
All supported fields - 
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 Note 
Reader fields without data selectors 

If a data selector is not configured, all the information supported by the reader is transferred 
as standard. This corresponds to the above-mentioned option "All supported fields". 

 

 Note 
Standard data selector 

RF-MANAGER Basic automatically creates a standard data selector that cannot be deleted. 
This is automatically assigned to the first notification channel to be created. As soon as you 
have created a new data selector, assignment of the standard data selector can be removed.

 

4.4 Working with system functions 

4.4.1 System functions - basics 

Introduction 
RF-MANAGER provides predefined system functions for some configuration tasks. You can 
use them to perform tasks direct in the reader without special programming skills.  

Use of system functions 
System functions provide support, for example, if you wish to assign a function to events:  

● Setting the output port of a reader 

● Setting a reader outport for specific tags. 
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Purpose 
You use system functions in a function list. You cannot change system functions, since 
system functions are pre-defined functions.  

When configuring a function list, select the system functions from a selection list that is 
sorted by categories: 

 

Language dependency 
The names of the system functions are dependent on the set project language. The 
functionality can then be recognized immediately by the project planner.  

4.4.2 Use of system functions 

Introduction 
A function list is processed in the reader when the configured event occurs. The reader 
triggers an event when e.g. a change at a digital input or a tag is detected.  

Applications 
You can configure system functions on all the objects that are able to react to an event. You 
can use system functions directly in function lists and thereby control the sequence.  

4.4.3 Working with function lists 

4.4.3.1 Basic principles of the functions list 

Introduction 
When the configured event occurs, you can perform several system functions with the 
function list.  
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Principle 
You configure the function list for an event of an object, e.g. tag detected. The events which 
are available depend on the selected object. 

 
Figure 4-9 Function list 

You can configure a function list precisely on every event. 

4.4.3.2 Properties of a function list 

Status information 
During configuration the project data is tested in the background. A status information 
returns in each function list the status of the respective system functions.    

The status information has the following meaning: 

● Orange: Function list is not performed in the reader because at least one system function 
or a script has not been supplied completely with parameters. 

Completion of system functions 
System functions in a function list are processed in the reader sequentially from top to 
bottom. 

     

4.4.3.3 Configure function list 

Introduction 
A function list is configured by selecting system functions from a selection list. The system 
functions are arranged in the selection list according to categories.    

Requirement 
Object has at least one configurable event. 
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Procedure 
1. Open the editor in RF-MANAGER Basic in which the object is located. 

2. Select the object with the mouse. 

3. In the properties dialog box, click on the event in the "Events" group for which you want to 
configure the function list. 

4. In the property view select the entry <No Function>" from the selection list with the 
mouse. 

5. Select the desired system function from the selection list. Alternatively, enter the name of 
the system function. 

 
Figure 4-10 System functions 

The system function is entered in the list of functions.  

6. If the system function has parameters, then select the values corresponding to the 
parameters. 

 
Figure 4-11 Parameter selection 

7. If you want to add other system functions or functions to the function list, then repeat 
steps four to seven. 

Result 
The function list is configured. In addition to the configured event, the status of the function 
list is displayed in the property view. When the configured event occurs in the reader, the 
function list is processed from top to bottom. 
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4.4.3.4 Editing function lists 

Introduction 
A function list can be edited as follows:    

● Completion order of the system functions and changing functions 

● Removing system functions or functions 

How a system function or function is added to a function list can be learned under 
"Configuring function lists". 

Requirement 
The function list is configured. 

Procedure 
1. Open the editor in RF-MANAGER Basic in which the object is located. 

2. Select the object with the mouse. 

3. In the properties window in the "Events" group, click on the event whose function list you 
want to edit. 

4. In order to change the completion order of the function list, select the desired system 
function in the selection list with the mouse. 

5. In the properties window click on the corresponding directional arrow until the system 
function is at the desired position. 

 
6. In order to remove a system function from the function list, select the desired system 

function with the mouse. Then click on the "Remove" button in the properties window. 
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Alternative procedure 

If you want to move several system functions simultaneously, you can select them in the 
function list. Press and hold <Ctrl> and select the required system functions with the mouse.  

You can also use the drag-and-drop function to move. 
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Reference 5
5.1 System functions 

5.1.1 Overview of system functions 
The following table shows an overview of the system functions which can be executed direct 
in the reader.  

Overview 
 
RF-MANAGER Basic 
SetIOPort 
SetIOPortOnCondition 
SetIOPortOnAlarm 

5.1.2 Description of the system functions 

5.1.2.1 SetIOPort 

Purpose 
Sets the specified output in the reader to the specified level.      

Syntax 
SetIOPort (Port, Level) 

Parameter 

Port 
The name of the output that is set.  

The following selection is possible for RF640R: 

● Outport00 

● Outport01 
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The following selection is possible for RF670R: 

● Outport00 

● Outport01 

● Outport02 

● Outport03 

Level 
Level to which the output must be set.  

This is selected from a drop-down list: ("OFF" or "ON"). 

 

Configurable objects 
 
Object Event 
RFID device On Alarm 
Data source Tag detected 

Read Requested 
Read Finished 

I/O Ports Level High 
Level Low 

Notification channel Data Sent 
Trigger Fired 

5.1.2.2 SetIOPortOnCondition 

Purpose 
Sets the specified output in the reader to the specified status when the specified condition is 
fulfilled.      

The condition is determined by the use of a tag selector. 

Syntax 
SetIOPortOnCondition(Port, Level, Condition) 
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Parameter 

Port 
The name of the output that is set.  

The following selection is possible for RF640R: 

● Outport00 

● Outport01 

The following selection is possible for RF670R: 

● Outport00 

● Outport01 

● Outport02 

● Outport03 

Level 
Level to which the output must be set.  

This is selected from a drop-down list: ("OFF" or "ON"). 

 

Condition 
Tag selector which must be fulfilled so that the output is set. 

Other information on tag selectors can be found in the chapter "Working with RFID objects". 

Configurable objects 
 
Object Event 
Data source Tag detected 
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Application example 

Objective 

Outport 1 is to be set for a specific tag ID. 

The tag ID is a 96 Bit-EPC-ID. 

Notes on configuration 

● Configure a tag selector with the following parameters: 

– Name = TagSelector_Condition 

– Tag field = Predefined tag field "TagId" 

– Filter = "Inclusive filter" with: 

Mask = FFFFFFFFFFFFFFFFFFFFFFFF 

Value    = 30B40242201D8840000FE632 

● For the data source at the event "Tag detected", configure the system function 
"SetIOPortOnCondition" with the parameters: 

– Port = Outport01 

– Level = HIGH 

– Condition = TagSelector_Condition 

Procedure in the reader 

As soon as the data source detects the tag with the defined tag ID, Outport 1 is set.  

"SetIOPortOnCondition" system function with "Tag detected" trigger 
The following requirements must be met if you want to use the system function 
"SetIOPortOnCondition" on a data source with the "Tag detected" trigger: 

Prerequisites 

1. Configure a tag selector with the required filter conditions and assign this to the system 
function as a parameter. 

2. To read out the data from the tag, configure an additional tag selector with identical 
settings to the previously configured tag selector but without filter settings. 

NOTICE  
 

Matching the data 

Ensure that the data of the tag field agree completely, including the name. Predefined 
tag fields may also be used alongside user-defined tag fields. 

3. Assign this second tag selector to the data source under "Data source > Properties > Tag 
selectors". 
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5.1.2.3 SetIOPortOnAlarm 

Purpose 
Sets the specified output of a reader to the specified level when a specified alarm is 
generated.      

Syntax 
SetIOPortOnAlarm (Port, Level, Alarm number) 

Parameter 

Port 
The name of the output that is set.  

The following selection is possible for RF640R: 

● Outport00 

● Outport01 

The following selection is possible for RF670R: 

● Outport00 

● Outport01 

● Outport02 

● Outport03 

Level 
Level to which the output must be set.  

This is selected from a drop-down list: ("OFF" or "ON"). 

 

Alarm number 
If this alarm number agrees with the alarm number triggered at the reader, the output is set. 
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Configurable objects 
 
Object Event 
RFID device On Alarm 
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Service & Support 6
 

Contacts   
If you have any further questions on the use of our products, please contact one of our 
representatives at your local Siemens office.  

The addresses are found on the following pages: 

● On the Internet (http://www.siemens.com/automation/partner) 

● In Catalog CA 01 

● In Catalog ID 10 specifically for industrial communication / industrial identification systems 

Technical Support   
You can access technical support for all IA/DT projects via the following: 

● Phone: + 49 (0) 911 895 7222 

● Fax: + 49 (0) 911 895 7223 

● E-mail (mailto:support.automation@siemens.com) 

● Internet: Online support request form: (http://www.siemens.com/automation/support-
request) 

Service & support for industrial automation and drive technologies 
You can find various services on the Support homepage 
(http://www.siemens.com/automation/service&support) of IA/DT on the Internet.  

There you will find the following information, for example: 

● Our newsletter containing up-to-date information on your products. 

● Relevant documentation for your application, which you can access via the search 
function in "Product Support". 

● A forum for global information exchange by users and specialists. 

● Your local contact for IA/DT on site. 

● Information about on-site service, repairs, and spare parts. Much more can be found 
under "Our service offer". 

RFID homepage 
For general information about our identification systems, visit RFID homepage 
(http://www.siemens.com/ident/rfid). 

http://www.siemens.com/automation/partner�
mailto:support.automation@siemens.com�
http://www.siemens.com/automation/support-request�
http://www.siemens.com/automation/support-request�
http://www.siemens.com/automation/service&support�
http://www.siemens.com/ident/rfid�


Service & Support  
  

 RF-MANAGER Basic V3 
132 Operating Manual, 09/2012, A5E03125518-03 

Technical documentation on the Internet 
A guide to the technical documentation for the various products and systems is available on 
the Internet:   

SIMATIC Guide manuals (http://www.siemens.com/simatic-tech-doku-portal)  

Online catalog and ordering system  
The online catalog and the online ordering system can also be found on the Industry Mall 
Homepage (http://www.siemens.com/industrymall). 

Training center    
We offer appropriate courses to get you started. Please contact your local training center or 
the central training center in  

D-90327 Nuremberg. 

Phone: +49 (0) 180 523 56 11 
(€ 0.14 /min. from the German landline network, deviating mobile communications prices are 
possible) 

For information about courses, see the SITRAIN homepage (http://www.sitrain.com). 

http://www.siemens.com/simatic-tech-doku-portal�
http://www.siemens.com/industrymall�
http://www.sitrain.com/�
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Appendix A
A.1 Flash codes and error messages of the RF600 reader 

Flash codes 
 

Flashing of ERR LED Error description 

Number Repetitions 
Reader inactive, no configuration data 1 Permanent 
Antenna 1 not connected or defective 3 Permanent 
Antenna 2 not connected or defective 4 Permanent 
Antenna 3 not connected or defective 5 Permanent 
Antenna 4 not connected or defective 6 Permanent 
Reading of user-defined memory has failed 11 3 times 
Writing of user-defined memory has failed 12 3 times 
The "SendCommand" function has failed 13 3 times 
Wrong or missing password 14 3 times 
Writing of the tag ID has failed 15 3 times 
LOCK has failed 16 3 times 
KILL has failed 17 3 times 
Access to impermissible memory areas 18 3 times 
Too many tags in the field 19 3 times 
General software errors 20 Permanent 
Impermissible message frame; 
Impermissible message frame parameter 

29 3 times 

Incorrect message frame format 30 3 times 
The "SetReadProtect" NXP function has failed 31 3 times 
The "ResetReadProtect" NXP function has failed 32 3 times 
General error during detection of tags (inventory) 33 3 times 

Error messages 
A description of the RF600 reader error codes can be found in the manual "SIMATIC RF 
Function Manual". 
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A.2 Open Source Software used in this product 

License Conditions and Disclaimer for Free Software 
The product "RF-MANAGER" (hereinafter referred to as "Product") contains the open source 
software listed below in unmodified or in a form modified by us (hereinafter referred to as 
"Open Source Software"): 

 
Name License 
TigthVNC GNU GPL 
RCS GNU GPL 
Xerxes Apache License 
OpenSSL OpenSSL license 
GoldParser GoldParser license 
MMC-Library V1.5 Common Public License 
zlib zlip license 
#ziplib GNU GPL 
libjpeg libjpeg Package License 
ACE 5.5 ACE license / DOC license 

The products "RF640R", "RF670R" and "RF-MANAGER" (hereinafter referred to as 
"Product") contains the open source software listed below in unmodified or in a form 
modified by us (hereinafter referred to as "Open Source Software"): 

 
Name License 
ACE 5.5 ACE license / DOC license 
GNU Libc LGPL 
U-Boot GNU GPL with additions 
Linux Kernel GNU GPL with addtions 
Busybox GNU GPL 
libstdc++ (gcc) GNU GPL with additions 
libcpp (gcc) GNU GPL with additions 

The Open Source Software is provided free of charge. You are entitled to use the Open 
Source Software in accordance with the respective license conditions (OSS License 
Conditions) listed below. If there are inconsistencies between the OSS License Conditions 
and the license conditions of the Product as per clauses 2 and 3 above, the OSS License 
Conditions shall prevail. In case of an infringement or breach of such OSS License 
Conditions the respective licensor named in such OSS License Conditions is entitled - in 
addition to ourselves - to bring forward and enforce the respective claims resulting from such 
infringement or breach in its own name. 

Insofar as the applicable OSS License Conditions provide for it you can order the source 
code of the Open Source Software from your Siemens sales contact - against payment of 
the shipping and handling charges - for a period of at least 3 years since purchase of the 
Product. 
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For the complete description of copyright notices, license texts and open source software 
please refer to the Online Help of RF-MANAGER Basic. 
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Glossary 

Active field 
Area with minimum field strength containing the sensing range. Within this sensing range, 
data can be read from the tag or written to the tag. 

Active surface 
See active field 

See active field 

Active surface 
See active field 

See active field 

Active tag/transponder  
Active transponders are battery-operated, i.e. they obtain the energy required to save data 
on the microchip from a built-in battery. They are usually in an idle state and do not transmit 
data in order to increase the energy source's service life. The transmitter is only activated 
when it receives a special activation signal.  

ALE interface 
Application Level Events (ALE) specifies an interface over which RFID data can be 
requested from higher-level systems. The data volume is reduced via ALE connections and 
the quality of the data stream is improved at the same time. The ALE interface can be used 
by higher-level systems for both synchronous and asynchronous reading of RFID data. ALE 
clients therefore only have a logical view of workplaces, detailed knowledge of the RFID 
system or readers is no longer necessary. 
For an ALE connection, ALE groups can also be configured that specify how the data 
records that have been passed on should be grouped for the report to the ALE client. 

AM 
Amplitude modulation; data are present in the changes in carrier frequency amplitude. 

Amplitude modulation 
See AM 
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Antenna switching 
The change antenna function switches antennas over between transmitting (TX) and 
receiving (RX) in accordance with the rotation principle. In practice, the system transmits on 
one antenna at one time and receives on the other antennas.  

Antennas 
Antennas read/write RFID data from/to the tags. They pass the read data onto the data 
sources. 

AS 
See Automation system 

ASM 
Interface module, see communication modules 

Automation system (AS) 
A programmable logical controller (PLC) of the SIMATIC S7 system, comprising a central 
controller, a CPU and various I/O modules. 

Battery-free data storage unit 
Mobile data storage units which operate without batteries (see transponders). Power is 
supplied to the data storage unit across an electromagnetic alternating field. 

Baud 
Unit (digits per second). 

Baud rate 
The baud rate describes the data transmission's digit rate. 

Byte 
One byte represents a group of eight bits. 

CE guidelines 
See CE Label 

CE Label 
Communauté Européenne (product mark of the European Union) 
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Communication modules 
Communication modules are used to integrate the identification systems in SIMATIC or 
SINUMERIK systems, or to connect them to PROFIBUS, PROFINET, PC or any other 
system. Once supplied with the corresponding parameters and data, they handle data 
communication. They then make the corresponding results and data available. Suitable 
software blocks (FB/FC for SIMATIC; C libraries for PCs with Windows) ensure easy and 
fast integration in the application. 

Continuous Wave 
See CW 

CW 
Continuous Wave; data are present in the carrier frequency which is switched on and off. 

Data rate 
The rate at which data are exchanged between the tag and reader. Typical units are bits per 
second or bytes per second. 

Data sources 
Data sources are the basic components for reading RFID data. They encapsulate the 
antennas assigned to them and the data received by them for the subsequent function units. 
In general, one RFID device can also contain more than one data source. Various different 
data sources can be defined so that mutually independent tasks can be performed with the 
same reader.  

Data transfer rate 
Number of characters which can be transmitted from a tag to a reader within a defined time. 
Baud rates are also used to specify how fast a reader can read information. 

Data transmission rate 
Unit of measurement for the volume of data transmitted within a unit of time, e.g. bytes/s, 
see also Baud 

dB 
See Decibel  

dBm 
Dimensional unit for the transmitted power in the logarithmic relation to 1 mW (Milliwatt).  

0 dBm = 1 mW, +23 dBm = 200 mW, +30 dBm = 1 W 
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dBr 
dB(relative); a relative difference to a reference value 

Decibel (dB) 
Unit of measurement for the logarithmic relationship between two variables. 

Detuning 
UHF antennas are tuned to receive a particular electromagnetic wavelength from the reader. 
If the antenna is too close to metal or a metallic material, it can be detuned, making the 
performance deteriorate. 

DHCP 
Dynamic Host Configuration Protocol 

Distant field communication 
RFID antennas emit electromagnetic waves. If a tag is further than one full wavelength from 
the transmit antenna of the reader, this is known as a distant field. If it is within one complete 
wavelength, this is known as the near field. 

The wavelength in the UHF RFID system is approximately 33 cm. 

The distant field weakens according to the square of the distance to the antenna and the 
near field weakens according to the cube of the distance to the antenna. Passive RFID 
systems based on distant field communication (UHF and microwave systems) have a greater 
read range than systems based on near field communication (typically low-frequency and 
high-frequency systems). 

Dwell time 
The dwell time is the time during which the transponder dwells within the sensing range of a 
reader. The reader can exchange data with the transponder during this time. 

Dynamic mode 
In dynamic mode, the data carrier moves past the reader at a traversing rate which depends 
on the configuration. Various checking mechanisms ensure error-free data transfer even 
under extreme environmental conditions. 

EAN  
European article number. Standardized barcode used in Europe, Asia and South America. Is 
administered by EAN International. 
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EBS 
Equipotential Bonding Strip 

Effective Isotropic Radiated Power 
See EIRP 

Effective Radiated Power 
See ERP. 

EIRP 
Effective Isotropic Radiated Power; unit of measurement for the transmission power of 
antennas (referred to an isotropic radiator) mainly used in the USA. EIRP is specified in 
Watt, and is not equal to ERP. (0 dbi = –2.14 dBm) 

Electromagnetic compatibility (EMC) 
Electromagnetic compatibility is the ability of an electrical or electronic device to operate 
satisfactorily in an electromagnetic environment without affecting or interfering with the 
environment over and above certain limits. 

EMC 
See Electromagnetic compatibility 

EMC directive 
Guidelines for electromagnetic compatibility This guideline relates to any electrical or 
electronic equipment, plant or system containing electric or electronic components. 

EPC 
Electronic Product Code. Standardized number system for identifying articles with a data 
width of either 64, 96 or 256 bits. 

EPCglobal 
The non-profit organization EPCglobal Inc. develops standards for uniform use of RFID 
technology throughout the entire supply chain spanning different countries and sectors. 
Development of the EPC (Electronic Product Code) was an important step in the direction of 
RFID standardization. 
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Equipotential bonding 
Potential differences between different parts of a plant can arise due to the different design 
of the plant components and different voltage levels. It is necessary to compensate for these 
differences by equipotential bonding. this is done by combining the equipotential bonding 
conductors of power components and non-power components on a centralized equalizing 
conductor (EBS = Equipotential Bonding Strip). 

ERP 
Effective Radiated Power; unit of measurement for the power of antennas (referred to an 
ideal dipole) mainly used in Europe. ERP is specified in Watt, and is not equal to EIRP. 
(0dbm = + 2.14 dBi) 

ESD directive 
Directive for handling Electrostatic Sensitive Devices 

ETSI 
European Telecommunications Standard Institute 

European Article Numbering 
See EAN. 

eXtensible markup language 
See XML. 

FCC 
Federal Communications Commission (USA) 

FHSS 
Frequency Hopping Spread Spectrum; frequency hopping procedure. 

FM 
Frequency modulation; data are present in the changes in the frequency of the carrier 
frequency. 

Frequency hopping 
Frequency hopping technique Automatic search for free channels.  
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In frequency hopping mode, data packets are transmitted between communication partners 
on continuously changing carrier frequencies. This makes it possible to react to interference 
from devices transmitting signals in the same frequency range (channel). If an attempt to 
send a data packet is unsuccessful, the packet can be transmitted again on a different 
carrier frequency. By default the RF600 uses this procedure (FCC) only in the USA and 
Canada. 

Frequency modulation 
See FM. 

Frequency Shift Keying 
See FSK 

FSK 
Modulation, Frequency Shift Keying; data are present in the changes between two 
frequencies. 

ICNIRP 
International Commission of Non Ionizing Radiological Protection 

ICRP 
International Commission of Radiological Protection 

Interface modules 
See communication modules 

Interrogator 
See readers 

ISO 
International Standard Organization 

ISO 18000 
Standard for data exchange of RFID systems between reader and transponder. There are 
various subdefinitions of this standard for the various approved frequency ranges for RFID. 
For example, the range 865 ... 868 MHz is described in ISO 18000-6.  
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LAN 
Local Area Network 

LBT 
Listen Before Talk; the reader only transmits when the channel is free. 

Limit distance 
The limit distance is the maximum clear distance between reader antenna and transponder 
at which the transmission can still function under normal conditions. 

Mass recording 
The capability of a reader to record several or many transponders quasi-simultaneously and 
to read the code. Contrary to the multi-tag capability, the reader is not able to specifically 
address individual tags. 

MDS 
Mobile data memory, see transponder 

MES 
Manufacturing Execution System 

Metal-free area 
Distance/area which must be maintained between the transponder and metal in order to 
prevent interference during data transfer between the transponder and reader. 

Mobile Data Memory (MDS) 
Mobile data memory, see transponder 

Modulation 
Modulation is a procedure with which one or more characteristics (e.g. phase, amplitude, 
frequency) of a carrier oscillation are modified according to the response of a modulating 
oscillation. 

MTBF 
Mean Time Between Failures of a device 
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Multi-tag capability 
Multi-tag capability means that a reader can communicate simultaneously with different data 
carriers. Therefore the reader can specifically address a transponder with its UID (see also 
mass recording). 

Near field communication 
RFID antennas emit electromagnetic waves. If a tag is further than one full wavelength from 
the transmit antenna of the reader, this is known as a distant field. If it is within one complete 
wavelength, this is known as the near field. 

The wavelength in the UHF RFID system is approximately 33 cm. 

The distant field weakens according to the square of the distance to the antenna and the 
near field weakens according to the cube of the distance to the antenna. Passive RFID 
systems based on near field communication (typically low-frequency and high-frequency 
systems) have a greater read range than systems based on distant field communication 
(typically UHF and microwave systems). 

Notification channels 
One or more data sources are assigned to notification channels as data suppliers. 
Notification channels are used for asynchronous read procedures. The notification channel 
passes on the RFID data to the data sources assigned to it in accordance with the 
configured triggering mechanism (notification channel trigger) and the data selector. 
Notification channels can reference more than one data source. The information from 
notification channels (if they have been created) is also requested in the synchronous read 
procedure. 

Passive tag/transponder  
A tag without its own power supply. Passive transponders obtain the energy required to 
supply the microchips from the radio waves they receive. 

PDM  
Pulse width modulation; data are present in the pulse width. 

Phase modulation 
See PM 

PLC 
Programmable Logic Controller, see PLC. 

Programmable logic controller; electronic device used in automation engineering for open-
loop and closed-loop control tasks. The typical modules of a PLC are the CPU, power supply 
(PS) and various input/output modules (I/O). 



Glossary  
  

 RF-MANAGER Basic V3 
146 Operating Manual, 09/2012, A5E03125518-03 

Programmable controller: The programmable logical controllers (PLC) of the SIMATIC 
system consist of a central controller, one or more CPUs, and various other modules (e.g. 
I/O modules).  

PLC 
Programmable Logic Controller, see PLC. 

Programmable logic controller; electronic device used in automation engineering for open-
loop and closed-loop control tasks. The typical modules of a PLC are the CPU, power supply 
(PS) and various input/output modules (I/O). 

Programmable controller: The programmable logical controllers (PLC) of the SIMATIC 
system consist of a central controller, one or more CPUs, and various other modules (e.g. 
I/O modules).  

PLC 
Programmable Logic Controller, see PLC. 

Programmable logic controller; electronic device used in automation engineering for open-
loop and closed-loop control tasks. The typical modules of a PLC are the CPU, power supply 
(PS) and various input/output modules (I/O). 

Programmable controller: The programmable logical controllers (PLC) of the SIMATIC 
system consist of a central controller, one or more CPUs, and various other modules (e.g. 
I/O modules).  

PM  
Phase modulation; data are present in the changes in carrier frequency phase. 

Programmable Logic Controller 
See PLC. 

Programmable logic controller  
See PLC 

Pulse width modulation 
See PDM 

Radio Frequency Identification 
See RFID. 
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Read procedures 
There are two different techniques for reading the data sources: 

● Synchronous read procedure 
A synchronous read procedure is when an ALE client of the enterprise system logs onto 
the report of the ALE interface and receives the required data automatically. 

● Asynchronous read procedure 
An asynchronous read procedure is when an ALE client of the enterprise system logs 
onto the report of the ALE interface and receives the data automatically. This continues 
until the client logs off again. 

Read rate 
Number of tags which can be read within a defined time.  
The read rate can also be used for the maximum rate at which data can be read from a tag. 
The unit is bits per second or bytes per second. 

Reader (also interrogator) 
Readers transfer data between the mobile data storage units (tags or transponders) and the 
higher-level systems. The data, including the energy required for processing and sending 
back, are transmitted to the transponder across an electromagnetic alternating field. This 
principle enables contact-free data transmission, ensures high industrial compatibility and 
works reliably in the presence of contamination or through non-metallic materials. 

Reader talks first 
A passive tag communicates in the read field of a reader with the reader. The reader sends 
energy to the tags which only reply when they are explicitly requested. The reader is able to 
find tags with a specific serial number commencing with either 1 or 0. 
If more than one tag responds, the reader can scan all tags commencing with 01 and 
subsequently with 010. This is referred to as "walking" on a binary tree, or "tree walking".  

Reading range 
The distance within which a reader can communicate with a tag. Active tags can cover a 
greater distance than passive tags because they use a battery to send signals. 

Report 
A combination of rules which manage communications systems. 

RFID  
Radio Frequency Identification; a method of identifying items using electromagnetic waves. 
The reader supplies energy to the tag and communicates with it. 
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RFID device 
The RFID device is a function block in RF-MANAGER and represents a reader. The 
following components are active in this function block: Antennas, data sources and 
notification channels. 

RFID systems 
SIMATIC RF identification systems control and optimize material flow and production 
sequences. They identify reliably, quickly and economically, use non-contact data 
communication technology, and store data directly on the product. They are also resistant to 
contamination. 

RH circular 
Right hand circular polarization 

RTNC 
Connector standard (Reverse TNC). Industrial coaxial connector with screw coupling, can be 
used for frequencies of up to 2 GHz. The mechanical design of the RTNC connector is not 
compatible with the TNC connector. 

RTTE 
Radio and Telecommunications Terminal Equipment 

SCM 
Supply Chain Management 

Secondary fields 
In addition to the main sensing range (antenna's main direction of transmission) there are 
secondary fields. These secondary fields are usually smaller than the main fields. The shape 
and characteristics of the secondary field depend on the metallic objects in the surroundings. 
Secondary fields should not be used in configuring. 

Selectors 
An RFID system that has been configured using RF-MANAGER recognizes different types of 
selectors. These are distinguished as follows: 
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● Tag selectors 
Tag selectors are components of data sources. They determine which tag data areas 
should be read or routed on. They also define which tags should be supplied or filtered 
out on the basis of the contents of these data areas. In this case, a tag selector orientates 
itself on the tag ID or the freely parameterizable user data of the tag. 

● Data selectors 
Data selectors are components of notification channels. They further dilute the 
information stream and specify which information should be passed on.  
In general, data selectors can also supply additional information (reader fields). This 
includes, for example, the time of the read. 

● ALE selectors 
ALE selectors reduce the data volume in accordance with the requirements of higher-
level systems and pass on the information in the form of ALE reports. ALE selectors can 
only sort EPC data; filtering of the freely parameterizable user data is not possible. 

SELV 
Safety Extra Low Voltage 

Sensing range 
Area in which reliable data exchange between transponder and reader is possible due to a 
particular minimum field strength. 

Smoothing 
Smoothing is a technique that is used to optimize the read quality. The RF-MANAGER 
marks the read event with a status description for the tag (e.g.: detected for the first time, 
reliably detected, lost) and adds these states to the read results. Time intervals are defined 
using this technique - for example, how long a tag detected for the first time has to be "seen" 
for it to be regarded as reliably detected. This allows tags to be excluded that have been 
unintentionally detected briefly in the boundary areas of the reader.  

SSB 
Single Sideband Modulation. SSB is similar to AM (amplitude modulation), however, only 
one sideband is sent instead of two sidebands. This saves 50% of the spectrum required in 
the HF channel without affecting the signal/data rate. For RFID applications, an HF carrier 
must also be sent to supply energy to the tag. Sending a carrier is many times not required 
for other SSB applications, since the HF carrier itself does not contain any data.  

Static mode 
In static mode the transponder is positioned at a fixed distance (maximum: limit distance) 
exactly above the reader.  
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Tag 
See transponder 

Tag talks first 
A passive tag communicates in the read field of a reader with the reader. When a tag 
reaches the field of a reader, it immediately indicates its presence by reflecting a signal. 

TARI 
Abbreviation of Type A Reference Interval. Duration (period) for representation of a bit with 
content 0. 

TCP/IP 
Transmission Control Protocol/Internet Protocol 

Telegram cycles 
A passive tag communicates in the read field of a reader with the reader. When a tag 
reaches the field of a reader, it immediately indicates its presence by reflecting a signal.  
Transmission of a read or write command is implemented in three cycles. They are called 
"Telegram cycles". One or two bytes of user data can be transferred with each command. 
The acknowledgment or response transfer (status or read data) takes place in three further 
cycles. 

Template 
The template is a configuration file (*.rf660r) which contains all of the country-specific 
parameters (such as radio and tag protocol settings) required for operating the reader. 

TNC 
Connector designation (Threaded Neill Concelman). 

Industrial coaxial connector with screw coupling, can be used for frequencies of up to 2 GHz.  

Transceiver (transmitter/receiver) 
Combination of transmitter and receiver. A unit which can both send and receive 
electromagnetic waves. 

Transmission distance 
Distance between communication module and transponder 
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Transponder 
An invented word from transmitter and responder. Transponders are used on the product, 
the product carrier, the object, or its transport or packaging unit, and contain production and 
manufacturing data, i.e. all application-specific data. They follow the product through 
assembly lines, transfer and production lines and are used to control material flow. 

Because of their wireless design, transponders can be used, if necessary, at individual work 
locations or manufacturing stations, where their data can be read and updated.  

Tree walking 
See Reader talks first. 

Triggers 
Triggers represent activation mechanisms that can be used to control asynchronous read 
and filter procedures. These are distinguished as follows: 

● Read triggers 
Read triggers cause the data source to read the data from the tags that are located in the 
field of the antennas. A continuous trigger can, for example, be configured that will cause 
the antennas to read constantly. 

● Notification channel triggers 
Notification channel triggers cause the notification channel to transfer the data from the 
data source assigned to it. A continuous trigger can, for example, be configured that will 
cause data to be transferred constantly. 

UHF  
Ultra-high frequency; frequency range from 300 MHz to 3 GHz. UHF RFID tags usually 
operate between 866 MHz and 960 MHz. This corresponds to a wave length of approx. 33 
cm. 

UID 
User IDentifier; the UID is an unambiguous number in the transponder, assigned by the 
manufacturer. The UID is unambiguous, and can usually also be used as a fixed code. The 
UID is used to specifically address a transponder 

Ultra High Frequency 
See UHF. 

User IDentifier 
See UID 
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VESA 
Video Electronics Standards Association (authority that defines standards for the PC 
industry) 

Walking 
See Reader talks first. 

WLAN 
Wireless LAN 

Workplaces 
Workplaces are used as an abstraction of the hardware. The relevant data sources and 
notification channels are grouped here into workplaces using the RF-MANAGER. In practice, 
workplaces are combinations of readers. 

Write/read distance 
See transmission distance 

writer 
See readers 

XML  
eXtensible markup language; XML is a language derived from SGML with which other 
languages (document types) can be described. In the meantime, XML has become a widely 
used method for distributing information over the Internet. Data exchange between reader 
and read station is carried out using XML commands. 
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* 
*.rfidb, 71, 72 
*.xml, 72 
*_log.ldf, 72 

A 
Antenna 

RFID device (reader), 15, 19, 23 
Antennas, 36 

ETSI radio profile, 107 
FCC radio profile, 107 
Radiated power, 107 

Application 
System function, 120 

Assign antennas 
Data sources, 108 

Assign data selector 
Notification channels, 114 
RFID device (reader), 103 

Assign data sources 
Notification channels, 114 

Assign event filter 
Data selector, 118 

Assign read trigger 
Data sources, 111 

Assign reader filter 
Data selector, 118 

Assign tag selectors 
Data sources, 111 

Assign type 
Trigger, 115 

Average read cycle time 
Data acquisition, 39 
Read cycle, 39 

C 
Change, 33 

User interface language, 33 
Close 

Project, 71 
configuring 

Function list, 121 
Connecting 

RFID device (reader) to parameterization 
computer, 63 

Consistency check 
project, 79 

Contact person 
RFID device (reader), 103 

Contacts, 131 
Copy 

Project, 72 
Courses, 132 

D 
Data acquisition 

Average read cycle time, 39 
Data source, 39 
Dead times data source, 41 
Further parameters for tag acquisition times, 42 
More than one data source, 41 
Poll cycle for RFID device, 41 
Read cycle, 39 
Read cycle time, 39 
Tag protocol, 39 
Time constant "Read timeout",  

Data selector 
Assign event filter, 118 
Assign reader filter, 118 
Name, 118 
Standard data selector, 118 

Data source, 36 
Data acquisition, 39 
Dead times, 41 
More than one, 41, 49 
Poll cycle, 43 
Read trigger, 16, 20, 24 
RFID device (reader), 15, 19, 24 
Smoothing, 16 
Tag event, 44 
Tag selector, 16, 20, 24 
Tag status information, 44 
Time constant "Read timeout",  
Trigger, 50 

Data sources 
Assign antennas, 108 
Assign read trigger, 111 
Assign tag selectors, 111 
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Enable, 108 
Glimpsed timeout, 110 
Lost timeout, 110 
Name, 108 
Observed threshold, 110 
Observed timeout, 110 
Read cycles per trigger, 109 
Read timeout, 109 
Session, 108 
Smoothing, 110 

Delete 
Project, 72 

Dense Interrogator mode 
RFID device (reader), 104 

Design 
Configuration and Operating Manual, 9 

Diagnosis view 
Display list, 86, 89, 92 
RFID device (reader), 83 

Display list 
Diagnosis view, 86, 89, 92 

E 
Editing 

Function list, 123 
Enable 

Data sources, 108 
Engineering support, 53 
EPC Class 1 Gen2 

RFID device (reader), 98 
EPC Class1 Gen2 

Tag communication scheme, 104 
ETSI radio profile 

Antennas, 107 
Event filter 

Notification, 50 

F 
FCC radio profile 

Antennas, 107 
Filter 

Tag selector, 116 
Frequency hopping 

RFID device (reader), 97 
Function list, 120 

Completion, 121 
configuring, 121 
Editing, 123 
Status information, 121 

System function, 121 

G 
Glimpsed timeout 

Data sources, 110 

H 
Help, 58 

display, 58 

I 
Initial Q 

RFID device (reader), 98 
IP address 

RFID device (reader), 96 

L 
Log file, 72 
Lost timeout 

Data sources, 110 

M 
Menu, 55 

Command, 55 
Move 

Project, 72 
Multi-language user interface 

RF-MANAGER, 60 

N 
Name 

Data selector, 118 
Data sources, 108 
Notification channels, 114 
Tag selector, 116 
Trigger, 115 

Notification 
Event filter, 50 
Function of the notification channel, 50 
Notification buffer, 51 
Report, 51 

Notification buffer 
Notification, 51 
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Notification channel, 36 
Data selector, 16, 20, 25 
Function, 50 
Notification channel trigger, 16, 20, 25 
RFID device (reader), 16, 20, 24 

Notification channels 
Assign data selector, 114 
Assign data sources, 114 
Name, 114 

O 
Observed threshold 

Data sources, 110 
Observed timeout 

Data sources, 110 
Online help, 58 

display, 58 
Open 

Project, 71 
Optimizing tag reading accuracy 

RFID device (reader), 105 
Output window 

Properties, 57 
Overview of tag status, tag events and tag times 

Smoothing / event generation, 49 

P 
Plausibility check 

project, 79 
Poll cycle 

Data source, 43 
RFID device, 41 

Port 
Ethernet, 63, 64 

Predefined tag field 
Tag selector, 116 

project 
Consistency check, 79 
Plausibility check, 79 
Resolve error, 80 
Testing, 79 

Project 
Closing, 71 
Copy, 72 
Delete, 72 
Move, 72 
Multiple sessions, 59 
Open, 71 
Save, 70 

Project database, 72 
Project view, 56 
Property view, 56 

Property, 56 

R 
Radiated power 

Antennas, 107 
Radio profile 

RFID device (reader), 96 
Read cycle 

Average read cycle time, 39 
Data acquisition, 39 
Read cycle time, 39 
Tag protocol, 39 
Time constant "Read timeout",  

Read cycle time 
Data acquisition, 39 

Read cycles per trigger 
Data sources, 109 

Read timeout 
Data sources, 109 

Reader location 
RFID device (reader), 103 

Reader role 
RFID device (reader), 103 

Report 
Notification, 51 

Resolve error 
project, 80 

RFID device 
More than one data source, 41 
Poll cycle for RFID device, 41 
Smoothing with more than one data source, 49 

RFID device (reader), 35 
Antenna, 15, 19, 23 
Assign data selector, 103 
Communications settings using the RF-MANAGER 
Engineering System, 66 
connecting through Ethernet port (RJ45 
interface), 64 
Contact person, 103 
Data source, 15, 19, 24 
Dense Interrogator mode, 104 
Diagnosis view, 83 
EPC Class1 Gen2, 98 
Frequency hopping, 97 
Initial Q, 98 
IP address, 96 
Notification channel, 16, 20, 24 
Optimizing tag reading accuracy, 105 



Index 
  

 RF-MANAGER Basic V3 
156 Operating Manual, 09/2012, A5E03125518-03 

Radio profile, 96 
Reader location, 103 
Reader role, 103 
RFID system, 15, 19, 23 
Standard data selector, 103 
Tag communication scheme, 98 
Test configuration, 81 

RFID system 
Components, 14, 18 
RFID device (reader), 15, 19, 23 
XML interface, 17, 25 

RF-MANAGER 
Monitoring inbound logistics and outbound 
logistics, 17 
Monitoring incoming goods, 14 
Multi-language user interfaces, 60 
Project View, 12 
RF-MANAGER workbench, 12 

RF-MANAGER Basic, 33 
Starting, 33 
System components,  

Runtime system 
Overview of system functions, 125 

S 
Save 

Project, 70 
Session 

Data sources, 108 
SetIOPort, 125 
SetIOPortOnAlarm, 129 
SetIOPortOnAlarm, 129 
SetIOPortOnCondition, 126 
Smoothing 

Data source, 16 
Data sources, 110 

Smoothing / event generation 
"Purged" event,  
More than one data source, 49 
Overview of tag status, tag events and tag times, 49 
Poll cycle of data source, 43 
Read cycle time, 47 
Reducing the volume of data, 43 
Tag events, 44 
Tag status "Glimpsed",  
Tag status "Lost",  
Tag status "Observed",  
Tag status information, 44 
Time constant "Glimpsed timeout",  
Time constant "Lost timeout",  
Trigger for data source, 50 

Standard data selector 
Data selector, 118 
RFID device (reader), 103 

Standard installation, 28 
Start menu, 33 
Starting, 33 

RF-MANAGER Basic, 33 
Status information 

Function list, 121 
System components 

RF-MANAGER Basic, 35 
System function, 119 

Application, 119, 120 
In function list, 120, 121 
Language dependency, 120 
Purpose, 120 

System functions, 125 
Overview, 125 
SetIOPort, 125 
SetIOPortOnAlarm, 129 
SetIOPortOnCondition, 126 

T 
Tab, 57 
Tag communication scheme 

EPC Class1 Gen2, 104 
RFID device (reader), 98 

Tag protocol 
Data acquisition, 39 
Read cycle, 39 

Tag selector, 36 
Filter, 116 
Name, 116 
Predefined tag field, 116 
User-defined tag field, 116 

Technical documentation 
On the Internet, 132 

Technical Support, 131 
Test 

project, 79 
Test configuration 

RFID device (reader), 81 
Tooltip, 58 
Training, 132 
Trigger 

Assign type, 115 
Name, 115 



 Index 
  

RF-MANAGER Basic V3 
Operating Manual, 09/2012, A5E03125518-03 157 

U 
User interface language, 33 

Change, 33 
User-defined tag field 

Tag selector, 116 

W 
Workplace, 56 

X 
XML interface 

Asynchronous read procedure, 17 
Reports, 51 
RFID system, 25 
Synchronous read procedure, 17 
XML commands, 51 

XML interface (external interface), 36 

 



Index 
  

 RF-MANAGER Basic V3 
158 Operating Manual, 09/2012, A5E03125518-03 

 


	RF-MANAGER Basic V3
	Table of contents
	1 Preface
	1.1 About this manual
	1.2 Further information
	1.3 Guide to the documentation

	2 Introduction to the RF-MANAGER
	2.1 Overview of the RF-MANAGER architecture
	2.1.1 Scenario 1: Monitoring incoming goods
	2.1.2 Scenario 2: Monitoring incoming goods and outgoing goods
	2.1.3 Scenario 3: Monitoring incoming goods, distribution of good, and outgoing goods
	2.1.4 Overview of the RFID functions of the reader


	3 Installation of the RF-MANAGER Basic
	3.1 Installing/uninstalling
	3.1.1 Installing RF-MANAGER Basic
	3.1.1.1 System requirements
	3.1.1.2 Installation overview
	3.1.1.3 Installation of the RF-MANAGER Basic
	3.1.1.4 Troubleshooting

	3.1.2 Uninstalling RF-MANAGER Basic

	3.2 Starting RF-MANAGER Basic
	3.3 Configuring RF-MANAGER Basic
	3.3.1 Changing the language

	3.4 Understanding and optimizing the scanning of RFID tags
	3.4.1 Introduction
	3.4.2 Objectives of this section
	3.4.3 Description of the basics
	3.4.4 The journey of the data of an RFID tag through the RF-MANAGER
	3.4.4.1 Work steps for asynchronous automatic tag data transmission
	3.4.4.2 Data acquisition
	3.4.4.3 Smoothing / event generation
	3.4.4.4 Who do I let know?
	3.4.4.5 XML interface
	3.4.4.6 Conclusion



	4 Working with RF-MANAGER Basic
	4.1 RF-MANAGER Engineering System
	4.1.1 Program desktop
	4.1.1.1 Desktop elements
	4.1.1.2 Menus and toolbars
	4.1.1.3 Workplace
	4.1.1.4 Properties view
	4.1.1.5 Output View
	4.1.1.6 Input fields

	4.1.2 Switching between reader components
	4.1.3 Displaying Help

	4.2 Working with projects
	4.2.1 Basics
	4.2.1.1 Configuration data
	4.2.1.2 Components of a project

	4.2.2 Multilanguage configuration
	4.2.3 Editing an existing project
	4.2.4 Creating a project
	4.2.4.1 Introduction
	4.2.4.2 Create a project
	4.2.4.3 Requirements for operating a project with a reader

	4.2.5 Project organization
	4.2.5.1 Save project
	4.2.5.2 Exit project
	4.2.5.3 Open project
	4.2.5.4 Managing projects in Windows Explorer
	4.2.5.5 Converting projects

	4.2.6 Transferring projects
	4.2.6.1 Requirements for transfer/back transfer
	4.2.6.2 Back transfer
	4.2.6.3 Export
	4.2.6.4 Import
	4.2.6.5 Delete
	4.2.6.6 Transfer

	4.2.7 Testing projects
	4.2.7.1 Troubleshooting
	4.2.7.2 Basic functional test of the reader using SIMATIC RF-MANAGER Basic
	4.2.7.3 Diagnosis view

	4.2.8 Firmware update

	4.3 Reader parameter assignment
	4.3.1 Introduction
	4.3.2 RFID device
	4.3.2.1 Tag modulation schemes
	4.3.2.2 Dense Interrogator mode

	4.3.3 Antennas
	4.3.3.1 Antennas
	4.3.3.2 Radiated power of antennas

	4.3.4 Data sources
	4.3.5 I/O Ports
	4.3.6 Notification channels
	4.3.7 Triggers
	4.3.8 Tag selectors
	4.3.9 Parameterizing data selectors

	4.4 Working with system functions
	4.4.1 System functions - basics
	4.4.2 Use of system functions
	4.4.3 Working with function lists
	4.4.3.1 Basic principles of the functions list
	4.4.3.2 Properties of a function list
	4.4.3.3 Configure function list
	4.4.3.4 Editing function lists



	5 Reference
	5.1 System functions
	5.1.1 Overview of system functions
	5.1.2 Description of the system functions
	5.1.2.1 SetIOPort
	5.1.2.2 SetIOPortOnCondition
	5.1.2.3 SetIOPortOnAlarm



	6 Service & Support
	A Appendix
	A.1 Flash codes and error messages of the RF600 reader
	A.2 Open Source Software used in this product

	Glossary
	Index

